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1 Getting Started

Introduction

PortraitPro is the easiest and fastest way to re-touch portraits, allowing you to achieve professional results in
minutes.

PortraitPro works in a completely different way to ordinary airbrushing and photo editing software normally used
by the pros. PortraitPro has been trained with hundreds of examples of human beauty, and as a result you can
add as much or as little photo enhancement as required - by simply moving sliders. 

Due to the innate knowledge of human beauty and expert lighting techniques that is built into PortraitPro, the
highest quality photo touch-up can be achieved by anyone in just a few minutes.

PortraitPro is available in three editions , Standard, Studio and Studio Max. All editions are covered by this
manual.

PortraitPro is available for Windows and Mac computers.  This manual is for the Windows PortraitPro.

Getting Started

Take a look at the Quick Start Guide  to see a quick overview of how to use PortraitPro.

The Step By Step Guide  provides more detailed information about each step.

If you need further help, please visit www.portraitprofessional.com/support where you see the latest FAQ, and
access our support ticket system. The support ticket system lets you send a question to our support staff.
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1.1 Quick Start Guide

PortraitPro will guide you through the process of enhancing a face.  You can use this quick start guide to
familiarize yourself with the stages.

Select the image to enhance

When you open PortraitPro, you will get the welcome screen.

Click on the Open Single Image button, or select Open... from the File menu. This brings up the file open dialog
where you can select the image you want to load.

PortraitPro will load your image and show it in the main working area, and then automatically find all the faces
in your image.

Select the face you want to enhance

The next step depends on how many faces are automatically detected in your image.

If one face is detected

The face is processed and shown in the Enhance Face  stage.

Unless you have enabled the automatic gender detector in the settings , the Select Gender  dialog
appears.  Press the Female or Male button to select the gender (or Child if the face is that of a young child).

If more than one face is detected

You will be shown all the faces that were detected.  You can select one to enhance , or you can manually
locate a face  if one was not detected automatically.

After enhancing the first face, press the Other Faces button at the Enhance Face  stage to return to the
Select Face  stage where you can select the next face to enhance.

If no faces are detected

If no faces are detected automatically, a dialog will appear to let you know.  When you close that dialog, you will
be at the start of the process to manually locate the face .

View the enhanced image and fine tune the results

Once you have selected a face you will be taken to the Enhance Face  stage.

You will see the original portrait on the left of the screen and the enhanced version on the right (you can change
this using the View Before And After and View After Only tabs above the picture).

Check the outline positions and gender/age

The outlines will be shown around the face in the before view.  Move the control points by clicking and dragging
if any are in the wrong place. As you move a control point, the enhanced face in the after view is updated to help
you find the best position for the point.

Occasionally, the automatic face detector might find a face where there isn't one. If this happens, just press the
white cross at the right of the header above the face to delete the outlines.  You will then be able to manually
locate the face.

17

80 78

18

21

17

18

21

17



PortraitPro 188

© 2018 Anthropics Technology Ltd.

The gender and age selected by the automatic gender detector is shown in the bar above the face in the before
view.  If this is wrong, use the radio buttons in the header above the face to select the correct one.

When you move the cursor out of the before view, the controls are hidden to help you compare the before and
after images.  To bring back the controls, move the cursor back into the before view.

Check the skin and hair areas

The skin and hair areas are found automatically.  You can check that the skin area has been found correctly by
pressing the View/Edit Skin Area button in the Skin Smoothing or Skin Lighting sections.  You can check that
the hair area has been found correctly by pressing the View/Edit Hair Area button in the Hair section.  If either
area is wrong, use the brushes to fix the area.  If the Extend brush is selected, then you can add to the area by
painting in the after view.  If the Cut Back brush is selected, you can remove from the area.

Fine tune the enhancements using the sliders

Hold down the ENTER key to flip between the before and after picture to see the improvements. 

To try different types of enhancements, press the Presets button to open the presets section, and then try some
of the presets.

You can quickly and easily fine tune any of the enhancements using the controls on the right hand side of the
screen.

At any time, you can now save your enhanced portrait by selecting "Save" from the File menu  at the top left of
the screen.

You can also save the whole project by choosing "Save Session" – this allows you to come back and edit the
portrait at a later time.

Other faces in the photo

If there is more than one face in the picture, press the  "Other Faces" button to go back to the Select Face
stage.

1.2 Top Tips For Best Results

If you just read one page in this manual, make it this one to get the best results out of PortraitPro.

Make sure the outlines are accurately placed

You will get the best results if the outlines are accurately placed.  Although the automatic face finder usually
does a good job of placing the outlines, you can sometimes improve the results by adjusting the positions of
the outlines.  In particular, make sure the outlines around the outside of the face follow the edge of the face. 
This is especially important if any skin re-lighting is being applied.

The outlines can be adjusted in the Before view at the Enhance Face  stage.

Don't push the sliders up too far

Often, you can greatly improve a picture with fairly subtle changes.

Push the sliders up just far enough to get the results you want.

If you go too far, the result can look unnatural.
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Don't use the sliders to fix small blemishes

You can avoid the need to push the sliders up too far by using the Touch-Up  tool to clean up spots and
blemishes. By correcting these areas specifically, you can leave the rest of the skin looking natural.

Make sure the skin area is right

PortraitPro automatically works out which areas in your picture are skin. However, you can sometimes improve
the results by adjusting the skin area selected.

Use the skin Extend and Cut Back  tools to refine the skin selection.

1.3 PortraitPro Editions

PortraitPro comes in three editions, Standard, Studio and Studio Max. The Standard edition is intended for
more casual users or amateur photographers. The Studio edition is intended for enthusiast or professional
users. The Studio Max edition has all the features of the Studio edition, and adds an automatic batch facility for
photographers who process a lot of images.

This manual covers all editions, with features that are only available in some editions indicated in one of these
ways:

Studio Max Edition Only

Studio & Studio Max Editions Only

Studio Edition Only

The following table shows the main features of PortraitPro, and which editions they are in.

Standard Studio Studio Max

   Automatic batch facility

   Manual batch facility

   Available as a Photoshop plug-in with Smart Filter
capability.

   Available as an Aperture plug-in

   Available as a Lightroom plug-in

   Read camera RAW format
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   Read Adobe DNG format

   Read & write TIFFs and PNGs containing 48 bits per color

   Support for JPEG, PNG and TIFF embedded color profiles

   Supports conversion between different color spaces

   Supports setting monitor and working color spaces

   Skin smoothing

   Skin re-lighting

   Skin re-coloring

   Face sculpting

   Eye enhancing

   Hair enhancing

   Mouth enhancing

   Apply makeup

   Manual touch-up brush

   Picture controls

   Background editing controls

   Unlimited fully customizable presets
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   Enhance more than one person in a photo

   Read and write JPEG, PNG and TIFF format images

   Free online support
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2 Step By Step Guide

This section of the manual describes the various stages that you may need to go through when you use
PortraitPro.

The most important stage is the Enhance Face  stage, which is where you view and can adjust the
enhanced image.

Most of the other stages are only needed if the automatic face detector did not find the face in your image
correctly, or if you are enhancing a group shot with several faces in one image.

2.1 Open An Image

The PortraitPro Welcome screen

When you run PortraitPro, it begins with the welcome screen:

Open a single image

To open an image to enhance, either:

· Press the Open Single Image button, or

· Select the Open command in the File menu .

This will bring up the File Open panel.

Browse to the file you want to enhance, and press the Open button.

Image types that PortraitPro can open .
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Once the image has been opened, PortraitPro will automatically detect all faces in the image, and determine
their gender.

If one face is found, then you will be taken to the Enhance Face  stage.

If more than one face is found, you will be taken to the Select Face  stage.

If no faces are found, you will be asked to manually locate the face .

Open a batch of images

If you have the Studio or Studio Max edition of PortraitPro , you will be able to open batches of images for
faster working.

The Studio Max edition has automatic batch processing .

The Studio edition has manual batch processing .

2.2 Automatic Batch Processing

Studio Max Edition Only

The Studio Max edition has automatic batch processing that lets you load a batch of images and have them all
processed automatically.

It lets you easily view each one to make any adjustments needed.

Opening a batch of images

To open a batch of images to process automatically, press the Open Image Batch button on the start screen.

This will bring up a File Open panel.

Browse to the folder containing the files you want to enhance, and select the images you want to enhance.

You can select more than one image in the File Open panel by holding down the CTRL key while clicking on
each image you want to add, or by dragging a box around several images.

Set the save options

Once you have selected one or more images to open, you will see the Auto Batch Save Options  dialog.  Use
this to set where and how the enhanced images should be saved, and defaults for gender, age and the preset
to use.

Press OK on this panel to continue.  Note, if you cancel the panel at this stage, the auto-batch will be closed.

Processing

While an automatic batch is open, you will see a film strip panel that shows thumbnails of all the images in the
batch.
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The screen-shot above shows the film strip on the left.  It also shows the summary view in the main window,
and the auto-batch controls in the control panel.

The images will be processed automatically.  The processing is performed in two passes.  The first pass just
finds all the faces in each image.  The second pass enhances each face.

If the Auto Save check-box on the Auto Batch Save Options  dialog is checked, then each image is saved
during a third pass.

At all times, this summary screen shows the state of each image.

Checking the results

Click on an image to select it.  You will then see that image in the main window.  If the image has been
processed, you will be able to view and adjust the enhanced face (or faces if there is more than one).

It is strongly recommended that you check each image, since the automatic face finder can sometimes
misplace the outlines which can cause problems with the enhanced image.

The main things to check for each face in each image are:

· Check that the outlines follow the edge of each feature, and the edge of the face (especially the chin).

· Check that the skin  and hair  areas are correct.

· Check that the gender and age is correct.

When you are happy with the result for an image, clicking on another image or going back to the summary view
and the image you were just viewing will be saved.

To get back to the summary screen shown in the screen-shot above, either click on the Show Summary button
at the top of the film-strip, or select the Show Summary menu command in the Auto Batch menu .
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2.3 Manual Batch Processing

Studio Edition Only

The Studio edition has manual batch processing that lets you load a batch of images and easily work through
them.

To use the manual batch processing, select the Open Batch command from the File menu .

This will bring up the Batch dialog  that lets you add files to the batch, and set the options for how the
images will be saved when you move to the next image in the batch.

When you use the manual batch processing, each image is loaded as if you had opened it in the usual way,
but without having to keep continually bringing up the file open dialog.

In addition, each image is saved to the folder selected in the Batch dialog without having to use the file save
dialog for every image.

This is done by using the Save And Open Next command after each image has been enhanced.  This
command is in the File menu , and is also or by pressing the Save And Open Next button on the toolbar
when enhancing a face .  This command is only shown if a manual batch session is active.

2.4 Enhance Face

After you have opened an image and the face has been detected, you are ready to start enhancing the face .

Viewing the result

You can choose whether you want to see the before and after image side by side, or whether you just want the
before or the enhanced image as large as possible. Use the tabs above the images to select which option you
prefer.

Whichever option you use, you can always flip the enhanced ("after") image back to the original ("before") image
to see the changes by pressing and holding the Enter key.

Important things to check

When you get to this stage for the first time with a new face, there are a few of things that you should check
before trying different presets or adjusting the sliders.  These are:

Check the outlines

The outlines will have been automatically placed around the face.  These are shown over the face in the before
view, so make sure the View Before and After tab is selected.

If the outlines do not appear, move the mouse into the before view to make them reappear.

The outlines should follow the edges of the features, and the edge of the face. If any are wrongly positioned,
move them into the correct place by moving the control points. To move a control point, move the mouse over it
until you see an orange cross, then click and hold down the mouse left button. Move the mouse to reposition
the point, and then release the button.

If you’re making significant changes to the outlines, or if you notice the software is slowing down when you
move points, click the Back button in the top right of the editing screen.
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Check the skin and hair areas

The skin and hair areas will have been automatically detected.  To check these, use the skin area  and hair
area  tools.

Check the gender and age category

The gender and age category (adult or child) will have been automatically detected.  This is shown in the
header above the face.  If this is wrong, move the mouse into the header to open it (if it is not already open), and
you will be shown a set of radio buttons that let you changed the gender and age category.

Note that this setting is used to help create the best result when enhancing the face.  It cannot be used to
change the appearance of the face to be the opposite gender or to change the apparent age.

Changing the result

PortraitPro will automatically enhance your image when you reach this stage. See presets  for how to
configure this default enhancement.

You can change how the image is enhanced by moving the sliders in the controls panel .

The sliders are grouped into sections that control various aspects of the face. Sections can be opened or
closed by clicking on their title button. This has a small triangle pointing down if the section is open, or right if
the section is closed. To toggle the effects of a whole section on or off, click the power symbol next to its title.

Try moving the Master Fade slider in each section to get an idea of the overall effect controlled by that section.

The lower sliders in each section give you finer control over the effect.

PortraitPro also comes with a library of presets, which set some or all of the sliders to predefined values to get
a particular effect. Try a few of these to see some of the enhancements possible for your photo.

The Snapshot function allows you to save your work at the current point and revert back to it later. Note that,
unlike Presets, these files are temporary and are not retained when opening a new image.

Saving the result

To save the result, select the Save command from the File Menu  or from the Next button at the top left. This
lets you save the enhanced image.

The Save Jpg/Tiff/Png option allows you to select the file format in which to save the image.

If you would like to save all the settings so that you can reload your image and continuing adjusting the sliders,
select the Save Session command from the File Menu . This saves the original image, all the point
positions, the skin and hair areas and all the sliders values into a proprietary ".ppx" file.

2.5 Select Face To Enhance

After you have opened an image, PortraitPro shows the image in the Select Face stage if either more than one
face was detected, or no faces were found.

You can also go to this stage at any time by selecting the Enhance Another Face In This Photo command in the
File menu, or by pressing the Other Faces button in the toolbar at the Enhance Face  stage.
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Outlines are shown around each face.  Check the gender and age category for the face, and then press the 
Continue button over the face to enhance that face.  You will be taken to the next stage where you can check
and adjust the outlines .

If you come back to this stage after a face has already been enhanced, you will see an extra button over the face
called Adjust Outlines. Press this button to go the stage where you can adjust the outlines.  The Continue
button will take you straight to the Enhance Face  stage when the face has already been enhanced.

Sometimes, you may find that a face has been detected in part of the image where there is no face.  You can
just ignore these extra faces, since no changes will be made to that part of the image provided you don't select
that face.  You can always delete any set of outlines around a face by clicking on the cross at the top right of the
face.

Enhancing a face that was not detected automatically

If the face you want to enhance was not detected (so there are no outlines around it), you just need to click on
the nose, and then the chin.

You will see that the cursor has a label next to it that says "Click on nose" until you have clicked on the nose. 
When you click on the nose, a cross appears that you can drag to reposition the nose point.  You can delete the
nose point by pressing the ESC key.

The cursor changes to "Click on chin" once the nose has been clicked to make it clear that you now need to
click on the chin.

Once you have clicked on the nose and chin, the face outlines will automatically be placed on the face.

Manual face location

Faces that are viewed in profile (side on) cannot be located automatically by PortraitPro.  For these faces, you
need to press the Manually Locate Face button.  You will then have to manually locate all the outlines
around the face.

22

17

21



PortraitPro 1820

© 2018 Anthropics Technology Ltd.

Controls for each face

For each face that has been located (whether automatically or manually), the outlines will be shown around that
face.

In addition, a header bar will be shown above the face, and below this, the Select and Adjust Outline buttons.

The header bar will be blue for faces that have not yet been enhanced, and green for those that have.

Control Description

Gender Indicator/Selector This is shown in the header bar.  When you move the mouse into the
header bar, it will open to let you set the gender and age category of
the face.  PortraitPro needs to know the gender of the face since it has
been trained separately on what makes female and male faces
attractive.

Delete Button This is the cross at the right of the header bar.  Press this to delete all
the data that PortraitPro has stored for this face.

Continue Button Selects the face to be enhanced.  The first time a face is selected, this
will take you to the Adjust Outlines  stage where you can view and
adjust the outlines.  If the face has already been enhanced, you can
press this button to make further changes.

Adjust Outlines Button This button only appears if the face has already been enhanced.  It lets
you make changes to the outlines around the features.  Note that you
can also adjust the outlines at the Enhance Image  stage, but you
may prefer to make these changes in the Adjust Outlines  stage
where you are also shown how the outlines should be positioned in a
reference image.

Gender/age symbols

The gender is shown using one of the following symbols:

Gender and age not set.  If either the Select or Adjust Outlines buttons are pressed when the gender
is not set, the Select Gender  dialog will be shown so that you can set the gender and age before
going to the stage requested.

Face is adult is female.

Face is adult is male.

Face is child, younger than about 12 years old.

When the age is set to "child", this will reduce the changes that can be applied to the shape of the face, since
generally changing the shape of a child's face is undesirable.

Rotating the image

If the image is in the wrong orientation, you can rotate it by pressing the buttons at the bottom of the control
panel.

Note: if the Select Gender dialog is shown, you will need to cancel it before pressing the rotate buttons.
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Enhance Skin Only

If no faces have been located, an extra button will appear in the control panel called Enhance Skin Only.

This lets you use just the skin enhancing parts of PortraitPro.  This lets you use PortraitPro even when there are
no faces in the image.

If you press the Enhance Skin Only button, you will then need to use the skin area brush tools  to manually
identify the areas in the image that are skin.

Note that when you are in enhance skin only mode, none of the controls that require a face will be available.

2.6 Manually Locate A Face

If the face in your image was not detected automatically, you will need to locate it semi-automatically or
manually.

To locate a face semi-automatically at the Select Face  stage, you just need to click on the nose, and then
click on the chin.  The features should then be automatically detected.

If the features are still not located properly, as a last resort you can locate the face manually.  This can be useful
if, for example, you are trying to locate a non-human face.

To locate a face manually, you first need to press the Manually Locate Face button at the Select Face  stage.

This will bring up the Select Gender  dialog to let you set the gender for the new face.

Locate 5 key features on the face

After you have selected the gender, the next step is to locate the positions of 5 key features on the face.

The 5 key features are:
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Locating the feature points

As you click on each point, PortraitPro will automatically move on to the next point.

You will be shown an example image to help you know where to place each point.

You can adjust the position of any points you have already marked by clicking on one of those points and
dragging it.

The cursor will have a small text label next to it to remind you which point you are locating. These labels can be
turned off if you don't like them using the General Settings  panel.

Zooming In

To help you to position the points more accurately, you can hold down the CTRL key to zoom in on the cursor.

Profile views

If the face is viewed side on, press the Profile View button at the bottom of the control panel.

If you are not sure whether the face is being viewed in profile or not, the main test is whether you can see both
eyes.  If you can't see one of the eyes due to the head being turned, press the Profile View button.

When you press the Profile View button, you will only need to locate one eye point, the nose tip, and one mouth
point.

Adjust the outlines

After you have located the 5 key features, PortraitPro will automatically place the outlines over the face and
show you the outlines in the Adjust Outlines  stage.

If any of the outlines are misplaced, correct these by moving the control points, before pressing the Next button
to go to the Enhance Face  stage where you can view and adjust the enhanced image.

2.7 Adjust The Outlines

Viewing and moving the outlines

The Adjust Outlines stage shows the outlines around the current face, and lets you adjust their positions.
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Note that this stage is optional, since the outlines will be automatically placed around each face when you load
an image.  If any of the outlines are misplaced, these can be moved at the enhance image stage  in the
before view.  However, if the automatic face finder has failed to find a face in your image, this stage lets you
position the outlines manually.

This stage is reached in one of these ways:

· Press the Back button at the Enhance Face  stage, or

· Press the Adjust Outlines button over a face at the Select Face  stage, or

· While manually locating a face .

If any of the outlines are not shown correctly around the features of the face, they should be moved to the correct
place.  A reference image in the control panel shows how the outlines should be positioned.

Adjusting the outline

The outline is shown as blue lines overlaid over your image in the main working view.  The lines can be moved
by dragging the control points.

The control points are shown differently depending on how they were set:

· The small yellow squares - these are points that have been placed by the automatic feature finder.  If
any of these points are in the wrong place, you will need to move them manually to the correct place.

· The small blue squares - these are points that you have placed.

· The light green circles - these are points that have been automatically placed based on where the other
points are.  Any of these points may move if any other points are moved.

Whenever you drag a control point, it will turn into a blue square to let you know that it is a point that you have
positioned.

For best results:
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· Try to move as few points as possible to line up the outline.

· Any points you do move, try to move as little as possible. If you spend a long time carefully
adjusting every point, not only are you wasting time, but you are likely to end up with a
worse result.

· Start by moving points that are already fixed - those shown as small yellow or blue
squares.  The more points you can leave as small green circles, the better.

To adjust the outlines around the eyes or mouth more accurately, click inside the dotted rectangles to zoom in
on that feature.  Click again to zoom back out.

Once the outlines are correctly positioned (or if no adjustment is necessary), press the space bar or click on
the Next button.

Adjusting the iris and pupil outlines

Two circles are shown inside the eye. The smaller (green) circle should fit around the pupil (the black part in
the middle of the eye). The larger (blue) circle should fit around the iris (the colored part of the eye). These
circles are positioned automatically, so you will not usually need to adjust them.

To move the circles, drag the point in the center of the circles.

To resize the circles, drag the outline in or out.

If the iris is not exactly circular, you can drag on the four small blue squares on the iris outline to make it an
ellipse.

If the center of the iris and the pupil are not exactly the same, you can move the pupil independently of the iris by
first clicking on the pupil circle, and then dragging the center point.  To go back to moving the iris and pupil
together, either click on the iris circle, or move the cursor away from the eye and back again.

Adjusting the outline for each feature

For greater accuracy, you can ask PortraitPro to show a zoomed in view of the main parts of the face to make it
easier to check the positions of the outlines.  This is done by clearing the Skip Zoomed In Steps When
Adjusting Outlines check-box in the General Settings  panel.

This will happen automatically for profile (side-on) faces regardless of this setting, since the automatic feature
finder does not support profile views.

PortraitPro will take you to each of the features in turn so that you can check, and if necessary, adjust the
positioning of the selected outline of each feature.

The features are shown in the following order.  

Left eye and eyebrow

The left eye outline is set automatically.  If it does not go correctly around the eye, adjust it by moving the control
points.

Depending on the shape of the eyebrow, it can be difficult to get the outline to fit around the eyebrow.  In these
cases, it is best to not worry about it and just get the position roughly correct.  Even if you are able to get the
outline to fit around the eyebrow reasonably well, if you had to move the points a lot to get it to fit, you may get a
better result by moving the points less even if the eyebrow outline no longer goes around the eyebrow
accurately.
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Right eye and eyebrow

The same comments about the left eye and eyebrow apply to the right eye and eyebrow.

Nose and Mouth

When you get to this stage the Mouth Open Or Closed panel will appear, provided it has not been turned off in
the General Settings . This panel has two buttons:

Mouth Open Press this button if the mouth of the face you are enhancing is open. You will then
see four lines between the corners of the mouth. The top two should be positioned
around the upper lip, and the bottom two around the lower lip. If the line along the
bottom of the top lip is placed close to the line along the top of the bottom lip, you
will see the line along the top of the bottom lip disappear leaving just the control
point in the middle.  The mouth will then be treated as closed anyway.

Mouth Closed Press this button if the mouth is closed. You will then see only three lines between
the corners of the mouth.  The center line should be placed along the line where the
lips meet.

If you are used to pressing the spacebar to quickly move on to the next stage, note you can
also use this to dismiss the dialog asking if the mouth is open or closed. If this happens, the
mouth will be selected as being open. If the mouth is in fact shut, you can either press the
Back button followed by the Next button, and the panel will appear again, or you can simply
move the middle two lines together.

Face outline

Try to avoid moving the face outline points around the face, just move them towards or away from the center of
the face.

Once you have been through all the features, press the Next button one more time to start PortraitPro
processing your image. You will then be taken to the Enhance Image  stage, where the fun begins!

2.8 Full Body Enhancement

PortraitPro is designed to enhance portrait photos. Please check out our product PortraitPro Body which is
specifically designed for full body enhancement.

However, if your photo includes other parts of the body, then you can use the skin enhancement tools on other
parts of the skin that can be seen.

To do this, all you need to do is make sure that the PortraitPro knows which parts of the photo are skin. This is
done using the skin area tools, as described in Skin Area .

2.9 Plug-in Mode

Using the PortraitPro Plug-in

Studio & Studio Max Editions Only
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The Studio edition of PortraitPro can enter a "plug-in mode".  This is intended for use when PortraitPro has
been launched by another application (such as Photoshop) to enhance an image that is being managed by the
other application. PortraitPro then behaves like a plug-in to the other application.

After the plug-in has been successfully installed as outlined in the Plug-in Installation Guide , you will be
able to use PortraitPro as a plug-in in any of the supported photo editing applications.

When PortraitPro is run as a plug-in from another application, the image or layer in the other application will
automatically be loaded into PortraitPro where you can enhance the faces in the usual way.  Once you are
happy with your results, press the Return From Plugin button on the toolbar at the Enhance Face  stage. 
This will close PortraitPro and return the enhanced image to the original application.  

When PortraitPro is in plug-in mode, the following changes occur:

· The only command in the File menu  is Return From Plugin.

· The crop tool  is not available when in plug-in mode, since the other application will generally expect the
image to still be the same size after it has been enhanced by PortraitPro.

Using PortraitPro from Photoshop

When the plug-in has been installed, PortraitPro will appear as a filter in Photoshop.  In the Photoshop Filter
menu, you will find a sub-menu called Anthropics, and in that you will find PortraitPro.

The PortraitPro filter works like other Photoshop filters in that it is applied to the current selection (or the whole
area if there is no selection) on the current layer.  When you select the filter, the image being filtered will
automatically be opened in PortraitPro.

Plug-in Location: Filter> Anthropics> PortraitPro
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2.10 Group Shots

Working with group shots

If there is more than one face in your image, you simply need to go through the enhancement process with
each face one by one.

If the automatic face detector found more than one face, you will arrive at the Select Face  stage after
opening the image.  Press the Select button over one of the faces to enhance it in the Enhance Face  stage.

To enhance another face in the image, return to the Select Face stage by:

· Pressing the Other Faces button in the toolbar at the Enhance Image  stage, or

· Selecting the menu command "Enhance Another Face In This Photo" from the File Menu   (keyboard
shortcut CTRL+E)

Either of these actions takes you to the Select Face  stage, where you can either start enhancing another
face in the image, or select a face you have already enhanced to make further adjustments.

You can repeat this process as many times as you need until every face in the image has been enhanced.
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3 Reference

This section provides information about the different menu commands and controls in PortraitPro.

The Menu Commands Reference  describes each menu command.

The Controls Reference  describes each of the controls available when you enhance an image .

The Dialogs Reference  describes the main dialogs that are used by the application.

3.1 Menu Commands Reference

These are the commands available on the menu bar in PortraitPro.

File Menu Commands to open and save files, print, or change settings

Edit Menu Undo & Redo

Auto Batch Studio Max Edition Only  This only appears when an automatic batch  is active.  It
contains commands to add and remove images from the batch, and to change settings.

View Menu Commands to control the view of the image

Help Menu Commands to launch help, check for updates, get support, or view about box

3.1.1 File Menu

The File menu contains the following commands:

Open... Opens a file (see Supported File Types ).

If a file is already open with unsaved changes, you will be prompted to save or
discard the changes before the new file is opened.

If you have the Studio Max edition, you will be able to select multiple files to open
as a batch.

Open Batch... Studio Edition Only

Opens the Batch  dialog.

Save And Open Next Studio Edition Only
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This command only appears when working on an image opened from the Batch
dialog.

Saves the current image, and opens the next one in the batch.

The folder where the file is saved, and the file format is set from the Batch dialog.

This command may appear as just "Open Next" if an image is opened from the
batch but is then closed using the File > Close command.

Save Saves the current file. The first time this command is used after opening a file, the
following rules apply:

If you opened a JPEG file, the enhanced image will be saved as a JPEG.

If you opened a TIFF file or any RAW file type (Studio edition only), the enhanced
image will be saved as a TIFF.

If you opened a session file (.ppx extension), the session file will be saved.

From then on, this command will save the same type of file as previously saved.

If this command is being used for the first time and a new file is being created, a
File Save panel will appear to let you select where to save the file.

This command is only available at the enhance image stage .

Save As... Saves the current file. This is similar to the Save command, except that a File Save
panel is always shown to let you select where to save the file.

This command is only available at the enhance image stage .

Save Jpg/Tiff/Png... Brings up the Save Image Options  panel to let you save the enhanced image as
a JPG, TIFF or PNG image file, and to set save options.

A File Save dialog will then appear to let you select where to save the file.

This command is only available at the enhance image stage .

Save Session... Saves the current session so that it can be opened again in PortraitPro.

PortraitPro sessions files are saved in a proprietary format that cannot be loaded
into any other applications. The file extension is ".ppx". They include the image
along with all the point positions, slider settings and masks.  They also include any 
snapshots  that have been saved for the image.

This command is only available at the enhance image stage .

Close Closes the current session. If there are any unsaved changes, you will be prompted
to save or discard these.

The Close command returns you to the Welcome screen .

Enhance Another Face
In This Photo

Goes to the Select Face  stage so that another face in the same image can be
enhanced.
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The same command is available on the Other Faces button in the toolbar at the
enhance image stage .

Settings... Brings up the Settings  dialog.

Note: On Macs, this command is called "Preferences" and is in the PortraitPro
application menu.

Print... Brings up the Print dialog that lets you print out the enhanced image.

Exit Closes the application. If there are any unsaved changes, you will be prompted to
save or discard these.

Note: On Macs, this command is called "Quit PortraitPro" and is in the PortraitPro
application menu.

Plug-in Mode

If the application is in plug-in mode , then the only command in the File menu is Return From Plugin, which
returns the enhanced image to the calling application and closes PortraitPro.

3.1.2 Edit Menu

The Edit menu contains the following commands:

Undo Provides undo for changes to slider values and changes made with the
brush tools.

This means it is safe to experiment with different saved settings, or try
moving any sliders, since you can always go back to the result you had
earlier if you don't like the changes.

This command is only available at the enhance image stage .

Redo Lets you redo an operation that has been undone with the Undo
command.

3.1.3 Auto Batch

Studio Max Edition Only

The Auto Batch menu appears when a batch is open.  It contains the following commands:

Show Summary Switches to the summary view which shows information about all the
images in the batch.

Change Settings Brings up the Auto Batch Save Settings  dialog.

17

82

25

17

9

73



Reference 33

© 2018 Anthropics Technology Ltd.

Add Images Brings up a file open dialog that lets you add more images to the
batch.

Remove Current Image Removes the current image from the batch.

Remove Failed Images Removes all failed images (if any) from the batch.  Failed images are
those that could not be loaded due to problems with the image file, or
those where no faces were found.

Remove Completed Images Removes all completed images (if any) from the batch.  Completed
images are those that have been processed and saved.

3.1.4 View Menu

The View menu contains the following commands:

Full Screen Makes the application fill the entire screen, to maximize the working area.

To restore the application to it's windowed state, select this command again.

Dock Control Panel Lets you select whether the control panel is docked to the main window, or a
separate floating window.

Occasionally, the control panel can get lost off screen when it is undocked. 
This command provides an easy way to bring it back.

Faster Rendering Increases the speed at which the enhanced image is calculated.

This is done by reducing the number of working pixels in the enhanced image.

This option is useful if the sliders are particularly sluggish on your machine.

If you find that the enhanced image looks too soft, you should turn this option
off.

Note: this option only affects how the enhanced image appears within the
application. It will make no difference to the quality of the image saved when
you use the File > Save Jpg/Tiff menu command.

3.1.5 Help Menu

The Help menu contains the following commands:

Contents Launches the online help, showing the table of contents.

Quick Start Guide Launches the online help showing the Quick Start Guide .

Keyboard Shortcuts Launches the online help showing the Keyboard Shortcuts .
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Disable All Pop-up Help Turns of all pop-up help messages.  This command only appears if any
pop-up help messages are enabled.

Re-Enable Pop-up Help Turns on all pop-up help messages that have been disabled. This
command only appears if you have disabled any pop-up help messages.

Show Background Tutorial Plays a short tutorial video demonstrating the best ways to use the
Background tools. 

Check For Updates... Launches the default web browser to show whether you have the latest
version of PortraitPro.

If updates are available, links will be provided for you to download them.

Support... Launches the default web browser to show the PortraitPro support pages.

You can use this to find answers to common questions, or to contact the
PortraitPro support team.

Forum... Launches the default web browser to show the PortraitPro user forum.

This is where you can join the PortraitPro community in discussions about
the product and photography in general.

About PortraitPro Brings up the About Box, which shows the version of PortraitPro that you
have.
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3.2 Controls Panel Reference

This section describes the main controls available when you are enhancing an image.

Enhance Image Controls Overview

Zoom Control  - Lets you select the area of the image that is shown

Under the zoom control are three tabs that let you view the main slider controls, the presets or the snapshots.

Slider Controls  - Click on the "Controls" tab to view the main slider controls (keyboard shortcut F9).  These
give you total control over the way the image is enhanced.

They are grouped into the following sections:

· Face Sculpt  - Let you control how the shape of the face is altered

· Skin Smoothing  - Let you control how the skin is enhanced

· Skin Lighting & Coloring  - Let you adjust the lighting on the skin and its color

· Makeup  - Let you add makeup to the face

· Eye  - Let you control how the eyes are enhanced

· Mouth & Nose  - Let you control how the mouth, lips and nose are enhanced

· Hair  - Let you control how the hair is enhanced

· Picture  - Controls that affect the whole image, such as brightness/contrast, and cropping

· Background  - Controls that let you set a background mask and set what happens in the background
area

Presets  - Click on the "Presets" tab to view the presets (keyboard shortcut F10).  Presets let you quickly
apply predefined settings to the face.  You can also save your own presets.

Snapshots  - Click on the "Snapshots" tab to view the snapshots (keyboard shortcut F11).  These are very
similar to presets, except they are stored for the current image only.
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Before Photo - Shows the original image

After Photo - Shows the enhanced image

Viewing the controls

The main sections in the controls panel (on the right in the screenshot above) can be opened or closed by
clicking on the buttons in the header of each section. These buttons have a small triangle next to them which
points down if the section is open, or to the right if the section is closed.

Resizing the controls

The control panel can be made wider or narrower by dragging the left-hand edge of the control panel.

Docking & undocking the controls

The controls panel can be undocked (made into a separate window) by double clicking on the header at the
top.

When it is undocked it can be freely moved around the screen.

It can be docked by double clicking on the header again.

Viewing the enhanced image

The default view when the application is first installed is for the original and enhanced images to be shown
side by side, as shown in the screenshot above.

The tabs above the images control the layout of the working view.

· Click on the View Before Only tab to have only the original image shown.  When the cursor is over this
image, the outlines around the face are shown, and can be dragged to reposition them.

· Click on the View After Only tab to have only the enhanced image shown.  If a brush tool is selected, you can
paint in this view to apply the brush.

· Click on the View Before And After tab to return to the side by side layout.  This tab is only shown if the
window is wide enough to allow two images to be shown side by side.

Flipping between the enhanced and original image

Whichever layout you have, you can press the ENTER key at any time to switch the enhanced image view to
show the original image. The original image is only shown while you hold down the ENTER key.

This lets you flip between the enhanced and original image which is a great way to see the changes.

Alternatively, you can click and hold the mouse button down on the button above the images that says Flip To
Before.

3.2.1 Zoom Control

The Zoom Control Panel is part of the control panel in the enhance photo stage.

It lets you see what part of the whole image is visible in the working view. It also provides controls to let you
zoom in and out, or pan the current view.
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The screenshot above shows the Zoom Control Panel.

The Zoom Control Panel contains the following controls:

Zoom Button Lets you collapse the Zoom control so that the image window is hidden. 

Click again to expand the Zoom control.

Zoom Slider Lets you zoom in (slide to the right) or out (slide to the left).

"Fit" Button Zooms the view so that the whole image is visible.

Keyboard shortcut: F7

"Face" Button Zooms the view to the face. 

Keyboard shortcut: F8

Zoom In/Out Button Shows a drop-down menu with various zoom scales.

The current zoom scale is checked.

The ratios are image pixels to screen pixels, as shown by these examples:

· 4:1 means 4 screen pixels are filled by 1 image pixel (the image is zoomed in by
a factor of 4).

· 1:4 means 1 screen pixel is covered by 4 image pixels (so the image is zoomed
out by a factor of 4).

The rectangle in the Zoom Control can be dragged to pan the view.
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Clicking outside the rectangle will center the view on that point.

The view can also be panned by using the Pan Tool .

Resizing the Zoom Control

The whole control panel (including the Zoom Control) can be made wider by dragging the right edge of the
control panel.

The Zoom Control can be made taller or shorter by dragging the space between the Zoom Control and the
Saved Sliders Control.

Keyboard Shortcuts

+ Zoom in.

- Zoom out.

3.2.2 Presets

To view the presets, click on the Presets tab, which is below the navigator in the controls panel (keyboard
shortcut F10).

Presets let you quickly set the values of several or all sliders.

Presets are divided into sections, which match the sections available in the main slider controls .  The
presets in each section only affect the sliders in the corresponding section in the main slider controls.

In addition, there is a section for Global presets.  Presets in this section affect all the sliders in all the sections.

Each preset has a name, and also shows an image showing the result of applying that preset to the current
face.

When PortraitPro is installed, it comes with a number of presets ready for you to use.

One of the global presets is used to set the initial slider values when a face is enhanced. The preset used can
be different depending on whether the face is female, male or child. To change which preset is the default for
new faces, use the Manage Presets  dialog.

Presets context menu

Right click on a preset to bring up its context menu.
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Update to Current Settings Stores the current settings in the selected preset.  If the
selected preset is a global preset, then all settings are saved.
 For other presets, only the settings for the section for that
preset are saved.

Rename Brings up a dialog that lets you rename the preset.

Delete Deletes the preset.

Edit Filter Settings Brings up a dialog that lets you change the filter settings for
the preset.  The filter settings let you hide presets that are not
appropriate for the current face, based on the gender or age of
the face. 

Set Default Female Sets this preset as the default preset for female faces.  Only
one face can be the default for female faces, so this preset
will replace the previous default.  This option is only available
for global presets.

Set Default Male As Set Default Female, except that it sets the default preset for
male faces.

Set Default Child As Set Default Female, except that it sets the default preset for
child faces.

Note: there is no undo/redo for changes made using the presets context menu commands.

Saving and managing presets

There are two buttons at the top of the presets panel:

Save Brings up the Save Presets  dialog. This lets you save the current slider values as a new
preset.

Keyboard shortcut: F2

Manage Brings up the Manage Presets  dialog. This lets you rename, re-order or delete presets. It
also lets you change the default female and male presets.

Reset to original preset

One of the built-in global presets is Reset to Original.  This resets all sliders to 0 so that all enhancements are
turned off.

Keyboard shortcut: F4

You can use this keyboard shortcut to reset all the sliders to 0 without having to navigate to the presets and find
the Reset to Original preset.  This shortcut will still work even if the Reset to Original preset has been deleted
using the Manage Presets  dialog.
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Copying presets between users

Presets saved from PortraitPro are stored per user.  The presets are stored in files, so it is possible to copy a
preset saved by one user to allow it to be used by another user.

Presets are stored under the user's data folder.  To find this folder, open Windows File Explorer, and then enter
this in the address box at the top: %APPDATA%.  Press the Enter key to open the user's data folder, and then
navigate to Anthropics/PortraitPro/UserPresets.

Presets are stored in the files with a .ppr extension.

The preset files can be copied from one user's UserPresets folder to another's.  The copied presets should
then appear in the other user's presets list in PortraitPro.  Note: if PortraitPro is already running, you will need to
restart it if you copy presets to the UserPresets folder.

3.2.3 Snapshots

To view the snapshots, click on the Snapshots tab, which is below the navigator in the controls panel (keyboard
shortcut F11).

Snapshots are very similar to global presets , except that they are only stored for the current image.  They
provide a way to store several sets of settings for the current image, that you can then quickly switch between.

To save a snapshot, switch to the Snapshots tab and then press the Save button.  Alternatively, you can press
the keyboard shortcut F3.  When you save a snapshot, you can optionally give it a name.  This will be shown
under the snapshot image when you view the snapshots.

If you save a PortraitPro session (using the Save Session command in the File  menu), then the snapshots
will be saved with that session and restored when you reload the session.  Otherwise, snapshots are lost
when you close the session.

To convert a snapshot to a preset, simply apply the snapshot to the current face, then save the current settings
as a preset.

3.2.4 Slider Controls

To view the slider controls, click on the Controls tab, which is below the navigator in the controls panel
(keyboard shortcut F9).

Sliders are the main way of controlling how your image is enhanced.

Sliders have no effect if they are set to 0, and an increasing effect as they are moved to the right (and left if they
have 0 in the center). 

You can double click on a slider to reset its value to 0.

Slider Sections

The sliders are organized into a number of sections.

Face Sculpt Subtly reshape the face to beautify facial features.
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Skin Smoothing Improve the appearance of the skin.

Also provides tools to let you refine the areas that PortraitPro treats as skin.

Skin Lighting & Coloring Lets you enhance or correct the lighting on the subject.  Also lets you adjust
the color of the skin.

Makeup Apply makeup to the face.

Eye Improve the appearance of the eyes.

Also provides an option to enable red-eye removal.

Mouth & Nose Improve the appearance of the mouth and nose.

Hair Improve the appearance of the hair.

Also provides tools to let you refine the areas that PortraitPro treats as hair.

Picture Control various aspects of the whole image, such as brightness and
contrast.

Also provides a tool that lets you crop the image.

Background Lets you set a background mask and set what happens in the background
area.

To reduce clutter on the screen, each section can be opened or closed by clicking on it's title button. The arrow
next to the title points right when the section is closed, and down when the section is open.

Each section can also be turned on or off by pressing the on/off button to the right of the section's title button.
When a section is turned off, it has no effect on the enhanced image. This can be useful to see what effect a
section is having.

Slider Organization

Sliders are organized in a hierarchy.

Some sections have a Master Fade slider that controls all the main sliders in that section. This lets you quickly
see how the controls in that section affect your image.

Underneath each master slider is a hierarchy of sliders that give you fine control over all aspects of the
enhancement.

If a slider has more sub-sliders underneath it, then the slider's label will be a button with a triangle to the left of
the label. Press this button to open the sub-sliders.

When you move a slider that has sub-sliders underneath it, the sub-sliders will move too.

When you move a sub-slider, you will also see the parent slider moves too, but to a lesser extent. This is
because the parent sliders always show a weighted average of the sliders underneath. This gives a rough
indication of the values of the sub-sliders even when the sub-sliders are closed.
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Using Sliders

Each slider controls the effect described by it's label.

For most sliders, you increase the effect by moving the slider to the right and decrease the effect by moving the
slider to the left. The exception is those sliders that allow negative values and have 0 in the center. For these
sliders, move the slider away from the center to increase the effect or back towards the center to decrease the
effect.

As you drag a slider, the enhanced image is updated in real-time so you can see what effect it has.

If a slider is at 0, then the effect it controls will make no change to the image.

Sliders with 0 in the center will "snap" to 0, which means they go to 0 if they are moved near 0.  If you want to get
a value near to 0 but are finding the slider is snapping to 0, you can hold the CTRL key to prevent the slider from
snapping to 0.

Instead of dragging a slider, you can click on its number value and use the up/down control to change the slider
position, or type a numeric value, or use the up/down cursor keys.

To find out what an individual slider does, hover over it with the mouse.

3.2.5 Face Sculpt Controls

PortraitPro gives you the ability to subtly reshape and enhance facial features, simply by moving sliders. Some
people regard this as going too far when enhancing a portrait. For those people, the shape sliders can simply
be left at 0 and PortraitPro will not change the shape. 

However, before dismissing this tool, we urge you to try it - you will be amazed at how much a subtle change to
the shape can lead to a dramatic improvement in your portrait. One good trick is not to do too much - you’re aim
is usually to make the subject look their very best, not like someone different. A great example of this is eye
widening, which makes your subject look alert and confident and draws attention towards the eyes.

Sliders

Master Fade This slider is connected to the other sliders in this section that perform general
enhancement to the shape of the face and facial features.  You will see the other
sliders move as this one is moved.  The sliders that are not connected to the
master fade slider are those that control effects that are likely to work well only on
specific faces, such as the lip plumping and eye widening sliders.

Face Shape Enhances the shape of the face.  Pressing the Face Shape button opens the
following sub-sliders:

Forehead Enhances the shape of the upper head.

Jaw Enhances the shape of the jaw.

Eyes Enhances the shape and position of both eyebrows and eyes. Pressing the Eyes
button opens the following sub-sliders:
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Left Eye Enhances the shape of the left eye only - useful for
evening out eye shape and size.

Right Eye Enhances the shape of the right eye only.

Eyebrow Shape Enhances the shape of the eyebrows.  Pressing
the Eyebrow Shape button opens two sub-sliders
that let you control the left and right eyebrow
shapes independently.

Cross Eyed Moves the eyes further apart (or closer together).

Eye Widening Widens (or narrows) the subject's eyes. Pressing the Eye Widening button
opens two sub-sliders that let you widen the left and right eyes independently.

Mouth Shape Enhances the overall shape of the mouth.  Pressing the Mouth Shape button
opens the following sub-sliders:

Smile Changes the mouth shape to make it look like a
smile.

Upper Lip Enhances the shape of the upper lip only.

Lower Lip Enhances  the shape of the lower lip only.

Expression Changes the mouth expression.

Blur Lip Line Blurs the line between the teeth and the lips to
prevent a jagged look that can occur when face
sculpting.  This slider does not appear if the mouth
is closed.

Plump Lips Makes the lips fatter.  Pressing the Plump Lips button opens two sub-sliders that
let you control the upper and lower lips independently.

Nose Enhances the shape of the nose. Pressing the Nose button opens the following
sub-sliders:

Shorten Nose Shortens (or lengthens) the nose  by changing the
size of the head.

Shorten Philtrum Shortens (or lengthens) the philtrum, which is the
gap between the bottom of the nose and the top of
the upper lip, by changing the length of the nose.

Slim Tip Shrinks (or enlarges) the tip of the nose.
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Slim Nose Narrows (or widens) the whole nose.

Neck Lengthens the neck.

Lens Correct When photographs are shot with a wide-angle lens (commonly seen with
cellphones) this can have the undesirable effect of distorting the facial features.
This slider can correct those problems.

Head Forward Moving the head towards the camera can have a flattering effect on the
appearance of the jaw. This slider simulates this.

Hair Volume Increases the volume of the hair.  This slider will have no effect if there is no hair
area  set, for example if the subject is bald.

Restore Glasses' Shape

If the subject is wearing glasses, there may be distortions to the shape of the frames when editing the shape of
the eyes. To fix this, check the Restore Glasses' Shape box.

Example

These pictures show how face sculpting can improve the appearance of a face.

  

3.2.6 Skin Smoothing Controls

The skin smoothing controls let you selectively remove or reduce wrinkles, spots, shine, shadows and other
skin defects while retaining a natural skin texture.
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PortraitPro automatically determines the skin area, but you will get better results if you check and fix the skin
area .

Sliders

Master Fade This slider is connected to the other sliders in this section that perform general
enhancements to the skin.  You will see the other sliders move as this one is
moved.

Around Eyes Reduces bags under the eyes, and reduces "crows feet", the wrinkles that appear
next to the outer corners of the eyes.  Pressing the Around Eyes button opens the
following sub-sliders that let you control these enhancements independently:

Lighten Eye Bags Reduces the appearance of bags under
the eyes by lightening the skin color in the
area where eyebags appear. Click the
triangle next to Lighten Eye Bags to
access sliders that let you control the left &
right eyes independently.

Smooth Eye Bags Reduces the appearance of bags under
the eyes by lightening the skin color in the
area where eyebags appear. Click the
triangle next to Smooth Eye Bags to
access sliders that let you control the left &
right eyes independently.

Smooth Crows Feet Smooths the areas to the left of the left eye
and to the right of the right eye where
crows feet appear. Click the triangle next to
Smooth Crows Feet to access sliders that
let you control the left & right eyes
independently.

Imperfections Subtly removes redness and reduces small skin blotchiness within the skin area.

Before After

Thin Wrinkles De-emphasizes wrinkles by making them thinner and lighter within the skin area.
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Before After

Fine Shadows Fades away dark specks and fine wrinkles within the skin area.

Before After

Remove Pores Removes pores within the skin area giving a smooth, airbrushed effect.

Before After

Remove Shine Corrects small areas of shine within the skin area.

Before After

Remove Grease Corrects larger areas of shine within the skin area.
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Sharpen Sharpens the skin area.

Trim Eyebrows Removes stray hairs from around the eyebrows.

Around Mouth Quickly clears up faults such as wrinkles from around the mouth.

Texture Maintains a natural look by applying realistic skin texture in areas where skin
texture is being corrected. This texture goes into touch-up brush strokes and areas
where the sliders have had an effect. You will need to zoom in the picture to see
the effect of changes to the skin texture. Clicking on the triangle next to Texture
opens the following sub-sliders:

Brightness Finer control over skin texture brightness.

Saturation Finer control over skin texture saturation.  The greater
the saturation, the more intense the color.

Size Makes the skin texture pattern larger or smaller.

Skin texture type.

There are a selection of skin textures to choose from.  You will need to zoom in on a skin area to see the effect
of changing the skin texture.

Removing Spots

PortraitPro automatically removes spots by default.

You can adjust the degree to which PortraitPro removes spots using the Spot Removal drop-down menu at the
top of the Skin Controls.

If you find that PortraitPro has not removed a spot, you can manually touch-up an area using the Touch-Up
brush.

If PortraitPro has removed a spot that you want to keep, you can manually restore it using the Restore brush.

More information about using brush tools .

Example

The Before and After pictures below show an example of how wrinkles were removed automatically by
PortraitPro:
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3.2.7 Skin Lighting & Coloring Controls

PortraitPro lets you change the lighting on the subject's face via simple controls.  These controls can provide a
very effective way to enhance the appearance of the face.

Note that some of these controls are quite sensitive to the positions of the outlines around the face.  If you are
not getting a good result, try adjusting the outlines  shown over the before view so that they line up with the
edges of the face.

Note: the sliders and other controls in this section only affect those parts of the picture that are in the skin
area .  Press the View/Edit Skin Area  button to change the skin area.

Lighting Direction

The general lighting direction can be changed by moving the circle in the control at the top of this section. 
Leave it in the center if you don't want to change the lighting direction.

Sliders

Contrast Changes the lighting contrast.

Modeling Relights the image to make the features of the face appear more sculpted or defined.

Fix Lighting Applies lighting similar to “beauty lighting” that makes skin and features appear
smoother.

Cheekbones Gives more definition to the cheekbones.  Pressing the Cheekbones button opens two
sub-sliders that let you change the left and right cheeks independently.

Left Shadow Adds shadow to the left side of the face.

Right Shadow Adds shadow to the right side of the face.

17
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Left Kick Adds a kick light to the left side of the face.

Right Kick Adds a kick light to the right side of the face.

Smokey Eyes Darkens the area above the eyes to simulate smokey eyeshadow or a stronger brow.

Pout Adds shadow below the lips to make them appear fuller.

Sculpt nose Adds definition to the nose.

Skin Color See the Skin Color sliders description below.

Skin Color

These are the sliders if you open the Skin Color section.

Skin Color Adjustment

(Color Correct and
more)

This slider can do different things depending on the setting of the drop down menu
on the left of the slider.

Color Correct:  A very general color correct that will fix badly colored skin.

Other options: Will change the skin color to match a particular style of coloring.

Two other sliders are affected by the skin color adjustment:

Brightness Contrast This controls how much the slider changes the
brightness and contrast (as opposed to just the
hue and saturation).

Color Correct Outside
Face

Copies the recoloring that was applied to the face
onto the rest of the picture.  This will correct the
white balance of the picture using knowledge about
the correct colors of skin.

Temperature Manually adjusts the color of the skin to remove any temperature (red-blue) color
cast.

Tint Manually adjusts the color of the skin to remove any tint (green-purple) color cast.

Tan Gives the skin area a tanned look.  Pressing the Tan button opens the following
sub-sliders:

Saturate Gives the skin area a richer color.

Darken Subtly darkens the skin area.
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Gold Gives the skin a golden color if moved to the right, or
reduces the amount of gold color in the skin if moved to
the left.

3.2.8 Makeup Controls

Makeup controls allow you to add realistic looking makeup after your picture has been taken.  This can be done
to make your subject look better, or just to explore different looks.

To start adding a makeup Element, just slide up the master slider (next to the element name) to increase the
opacity of that element.  All makeup elements come with sensible defaults that can be altered as described
here.

Hair covering the face: Because makeup shouldn't appear over the top of hair, if there is hair covering any area
where makeup is applied, adjust the Hair Area (found in the Hair controls) to paint away makeup in areas
where there is hair.

Objects covering the face: Sometimes glasses, accessories or hands may be covering an area where
makeup is being applied. To prevent this, use the Restore Brush set to Restore To Original image to paint over
the area.

Profile faces: please note that makeup is not supported for faces that are viewed in profile, so the makeup
section will not appear for those faces.

Makeup Elements

Lipstick Lipstick isn't just for giving the appearance of lipstick, it can also be used to cover
faults on the lips (using the coverage slider).

Master slider The master slider controls the opacity of the entire
lipstick.  All the controls under it are affected by the
opacity.  Because you won't see any difference to
the lipstick when the opacity is at 0, it will
automatically jump to 75% when adjusting any of
the other controls.

Texture Use this to control the material property of the
lipstick. The best way to understand this is just to
scroll through the different options to see what
they do.

Color The color of the lipstick is controlled using the
brightness slider and the hue and saturation
picker underneath.   Drag the "plus"  around to
alter the hue and saturation.

Shine This is used to tweak the amount of shine added
to the lipstick.   
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Coverage This affects how much of the original shine from
the lips is visible.   When applying to already shiny
lips, a low coverage can result in overly shiny lips.
  A higher coverage can cover faults in lips better,
but can end up looking artificial as the original
lighting is discarded.

Mascara Mascara can be used to draw attention to the eyes.

Master slider The master slider controls the opacity of the
mascara.  All the controls under it are affected by
the opacity.  Because you won't see any difference
to the mascara when the opacity is at 0, it will
automatically jump to 75% when adjusting any of
the other controls.

Application Use this to choose what style the mascara
appears in.

Softness Because sometimes eyes are slightly out of
focus, Portrait Pro measures the focus of the
original pictures eyes and tries to match the
mascara softness to it.   This slider can be used
to manually tweak the default focus detection.

Nudge lashes Portrait Pro uses the eye markup in the "before"
panel to place the mascara.   The markup should
be placed where the waterline meets the eyeball. 
Lashes come out of the outside of the waterline,
so there is a gap between the markup and the
roots of the mascara.  However if the head is
tilted, the waterline can be larger or smaller.  This
slider lets you adjust the position of the mascara
to compensate in these situations.

Texture Adds a texture to the mascara.

Eyeshadow (upper and
lower)

Eyeshadow can be used to draw attention to the eyes.

Master slider The master slider for the eyeshadow element
controls the opacity of the entire eyeshadow.  All
the controls under it are affected by the opacity. 
Because you won't see any difference to the
eyeshadow when the opacity is at 0, it will
automatically jump to 75% when adjusting any of
the other controls.

Texture Use this to control the material property of the
eyeshadow. The best way to understand this is
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just to scroll through the different options to see
what they do.

Color The color of the eyeshadow is controlled using
the brightness slider and the hue and saturation
picker underneath.   Drag the "plus"  around to
alter the hue and saturation.

Shine This is used to tweak the amount of shine added
to the eyeshadow.   

Inner/Outer opacity This is used to change the opacity of the inside or
outside parts of the makeup.

Eyeliner Eyeliner can be used to draw attention to the eyes.

Opacity Controls the opacity of the eyeliner.

Application Controls the shape of the eyeliner.

Texture Adds a texture to the eyeliner.

Blusher Blusher is used to give cheeks a rosy glow.

Master slider The master slider controls the opacity of the
blusher.  All the controls under it are affected by
the opacity.  Because you won't see any difference
to the blusher when the opacity is at 0, it will
automatically jump to 75% when adjusting any of
the other controls.

Face shape You can adjust the blusher to flatter different face
shapes.

Color The color of the blusher is controlled using the
brightness slider and the hue and saturation
picker underneath.   Drag the "plus"  around to
alter the hue and saturation.

Bronzer Bronzer is way to sculpt the face while giving a tanned look.

Master slider The master slider controls the opacity of the
bronzer.  All the controls under it are affected by
the opacity.  Because you won't see any difference
to the bronzer when the opacity is at 0, it will
automatically jump to 75% when adjusting any of
the other controls.
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Color The color of the bronzer is controlled using the
brightness slider and the hue and saturation
picker underneath.   Drag the "plus"  around to
alter the hue and saturation.

Highlighter Highlighter is used to sculpt the face while making it glow.

Master slider The master slider controls the opacity of the
highlighter.  All the controls under it are affected by
the opacity.  Because you won't see any difference
to the highlighter when the opacity is at 0, it will
automatically jump to 75% when adjusting any of
the other controls.

Color The color of the highlighter is controlled using the
brightness slider and the hue and saturation
picker underneath.   Drag the "plus"  around to
alter the hue and saturation.

Eyebrow Pencil When using the eyebrow pencil controls, make sure the eyebrow outlines are
correctly positioned over the eyebrows.  If they are not correctly positioned, you
can move them in the "before" view.

Master slider The master slider controls the opacity of the
eyebrow pencil.  All the controls under it are
affected by the opacity.  Because you won't see
any difference to the eyebrow pencil when the
opacity is at 0, it will automatically jump to 75%
when adjusting any of the other controls.

Color The color of the eyebrow pencil is controlled using
the brightness slider and the hue and saturation
picker underneath.   Drag the "plus"  around to
alter the hue and saturation.

Left and right Use this to individually adjust the left and right
opacity.

Example

These pictures show how  makeup can subtly improve the appearance of a face.
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3.2.9 Eye Controls

PortraitPro can automatically brighten, whiten and sharpen the eyes. The Eye controls allow you to adjust
exactly how much effect you get. You can also change the color of the eyes.

Partially obscured eyes: The eye sliders look bad when applied over hair that covers eyes. If there is hair
covering the eyes, use the Hair Area brush (found in the Hair controls) to paint away the effect of eye sliders by
marking pixels as hair.

If another object (such as a hand or glasses) is covering the eye, you can use the Restore Brush to prevent
edits being made to that item. Simply select Restore To Original Image and paint over the object.

Totally obscured eyes: If one of the eyes is completely obscured, you can turn off all changes to that eye using
the Eye On/Off buttons at the top of the Eye menu. If both eyes are obscured, simply turn off the eye menu
entirely using the power button next to its header.

Sliders

Master Fade This slider is connected to some of the other sliders in this section that
perform general enhancements to the eyes.  You will see the other sliders
move as this one is moved.

Whiten Eyes Whitens and brightens the white part of the eyes. The area affected is
controlled by the Whitening Area slider.

Whitening takes any color out of the whites of the eyes leaving them a
shade of gray when the slider is at the top.

Pressing the Whiten Eyes button opens two sub-sliders that let you
whiten the left and right eyes independently.
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Clean Eyes Cleans up veins and other discolorations in the whites of the eyes. The
area affected is controlled by the Whitening Area slider.

Pressing the Clean Eyes button opens four sub-sliders that let you control
the left and right eyes independently.  The sub-sliders Left Eye and Right
Eye let you control the overall effect for each eye, from 0 (no effect) to 100
(maximum effect).  The sub-sliders Left Curve and Right Curve can be
used to either increase the apparent curvature of the eye by moving the
slider to the right, or make the eye appear flatter by moving the slider to the
left.  The curve sliders work by adjusting the cleaning effect added, so they
will have no effect if the corresponding left/right eye slider is 0.

Whitening Area Changes the area of the eye that will be whitened or cleaned by the Whiten
Eyes or Clean Eyes sliders.

Pressing the Whitening Area button opens two sub-sliders that let you
change the area for the left and right eyes independently.

Darken Pupil Darkens the pupil (the black part in the middle of the eye) in the eyes.

Pressing the Darken Pupil button opens two sub-sliders that let you
darken the left and right pupils independently.

Darken Pupil Size Use to change the size of the pupil when darkening.

Pressing the Darken Pupil Size button opens two sub-sliders that let you
change the left and right pupils independently.

Sharpen Eyes Sharpens the subject's eyes.

Pressing the Sharpen Eyes button opens the following sub-sliders that let
you control the amount of sharpening applied to different parts of the eyes.

Upper L Lash Sharpens the upper left eye lashes.

Lower L Lash Sharpens the lower left eye lashes.

Left Eye Sharpens the left eye.

Left Lash Area Changes the size of the area that the left
eye sharpening influences.

Upper R Lash Sharpens the upper right eye lashes.

Lower R Lash Sharpens the lower right eye lashes.

Right Eye Sharpens the right eye.

Right Lash Area Changes the size of the area that the right
eye sharpening influences.
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Sharpen Eyebrows Sharpens the subject's eyebrows.

Pressing the Sharpen Eyebrows button opens two sub-sliders that let you
sharpen the left and right eyebrows independently.

Brighten Iris Brightens or darkens the iris (the colored part of the eye).

Pressing the Brighten Iris button opens two sub-sliders that let you
brighten or darken the left and right irises independently.

Change Eye Color Press the Change Eye Color button to open the sub-sliders that let you
change the color if the irises.

Amount of Change If this slider is 0, the color of the eyes
will be unchanged (the Color and
Intensity sliders will be ignored).

Set this to 100 to set the eye color
selected by the Color and Intensity
sliders. Lower values will blend
between the selected color and the
original eye color.

If this slider is at 0, it is automatically
set to 100 whenever the Color or
Intensity sliders are moved.

Press the Amount of Change button to
open two sub-sliders that let you set
the amount of change for the left and
right eyes independently.

Color Sets the color of the eyes (provided the
Amount of Change slider is not 0).

Press the Color button to open two
sub-sliders that let you set the color for
the left and right eyes independently.

Intensity Sets the intensity of the eye color.

Press the Intensity button to open two
sub-sliders that let you set the
intensity for the left and right eyes
independently.

Add Contact Lens You can choose from a list of contact lens options to be applied to the eye.
 There is an opacity slider to fade it in and out and a scale slider to change
the size.

Add Eyelid Accentuates the line above the eye where the eyelid starts.
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Remove Pupil Reflection This slider blackens the pupil area to remove reflections. This can be
used with the Add Reflection drop down list to add new eye reflections.

Pressing the Remove Pupil Reflection button opens two sub-sliders that
let you remove catch-light reflections from the left and right pupils
independently.

Add Reflection You can choose from a selection of reflection images (catch-lights) to be
added to the eyes.

Reflection Opacity You can adjust the opacity of the reflection images.

If this is set to 0, the reflection will not appear.

If this is set to 100, the reflection is shown at its maximum intensity.

If you cannot see the reflection even when this slider is set to 100, it is
possible the reflection is outside the eye area.  Move the nudge reflections
sliders to bring the reflection into view.

Nudge Reflections If you have added a reflection to the eye using the Add Reflection drop
down list, you can press the Nudge Reflections button to open up sliders
that let you move the position of the reflections in the eyes.

These sliders do not appear if the Reflection Opacity is 0.

Left Eye Horiz. Moves the reflection in the left eye
horizontally (left & right).

Left Eye Vert. Moves the reflection in the left eye
vertically (up & down).

Right Eye Horiz. Moves the reflection in the right eye
horizontally.

Right Eye Vert. Moves the reflection in the right eye
vertically.

Red Eye Removal

If your photo has "red-eye" (caused by a flash illuminating the insides of your subject's eyes), this can be
automatically removed by checking the Red Eye Removal box at the top of the Eye controls.

Example

The Before and After pictures below show an example of how the model’s eyes were whitened and sharpened
automatically by PortraitPro.
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3.2.10 Mouth & Nose Controls

PortraitPro automatically whitens the teeth and enhances the color of the lips. The Mouth & Nose controls allow
you to adjust these effects to get exactly the look you want.

Sliders

Master Fade This slider is connected to some of the other sliders in this section that perform
general enhancements to the mouth and nose areas.  You will see the other sliders
move as this one is moved.

Whiten Teeth Removes any color from the teeth. The area affected is controlled by the Whiten
Area slider. This control is not shown if the mouth is closed.

Clean Teeth Cleans the teeth. The area affected is controlled by the Whiten Area slider. This
control is not shown if the mouth is closed.

Whiten Area Changes the teeth area affected by the Whiten & Clean Teeth sliders. This control is
not shown if the mouth is closed.

Lip Saturation Makes the lips more colorful.

Lip Darken Move this slider to the right to darken the lips, or to the left to make them lighter.

Lip Contrast Increases the contrast within the lip area, giving the lips more impact.

Sharpen Mouth Sharpens the outline and details of the mouth.  Press the Sharpen Mouth button to
open the following sub-sliders that let you control the amount of sharpening applied
to the different parts of the mouth independently.

Top Lip Sharpens the top lip only.

Bottom Lip Sharpens the bottom lip only.

Sharpen Teeth Sharpens the teeth.

Nose Contrast Increases the contrast within the nose to draw attention to it.

Moisten Lips Adds some shine to the lips.

Lip Hue Changes the color of the lips.
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Example

  

3.2.11 Hair Controls

PortraitPro lets you enhance the hair of the subject by moving sliders. Please note that before doing this, it is
important to have the hair area set reasonably accurately – see Hair Area .

Sliders

Hair Recolor Amount Controls how much hair recoloring to apply.

The color is set by selecting one of the hair swatches in the Hair Recolor drop-
down list.

This slider will be automatically set to 75 if it is at 0 when a hair color is selected
in the Hair Recolor drop-down list.

Shine Makes the hair more or less shiny.

Lighten Makes the hair lighter or darker.

Redden Alters the coloring of the hair. Higher values are redder, while negative values
tend to make the hair grayer.

Vibrance Increasing the vibrance will make the color of the hair more intense.

Hair Tidying Mode

Further controls are located in Hair Tidying Mode. Click on Go to Hair Tidying Mode to access these sliders.

Fill Hair Shadows Fills out shadows within the hair caused by hair clumping.
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Before After

Press the Fill Hair Shadows button to open the following sub-sliders to give finer
control over the enhancement:

Shadow Brightness Controls how bright to make the shadows
brightened by the "Fill Hair Shadows" slider.

Shadow Texture Controls how much texture to reveal in the
shadows brightened by the "Fill Hair
Shadows" slider.

Smooth Hair Makes hair appear smoother and tidier.

Before After

Press the Smooth Hair button to open the following sub-slider that gives further
control over the way the hair is smoothed:

Smoothing Softness Alters the degree to which the Smooth Hair
slider makes the hair appear soft.

Leave Hair Tidying Mode by pressing the OK button.

3.2.12 Picture Controls

These controls affect the whole image and allow you to adjust the overall look of the picture, controlling things
like the contrast and color temperature.

You can also crop the image using the Crop tool .91



Reference 61

© 2018 Anthropics Technology Ltd.

Sliders

Temperature Adjusts the color of the whole image to remove any temperature (red-blue) color
cast.

Tint Adjusts the color of the whole image to remove any tint (green-purple) color cast.

Exposure Adjusts the overall exposure (brightness) of the whole image.

Pressing the Exposure button opens the following sub-slider that provides an
alternative exposure control.

Color Preserving
Exposure

Adjusts the overall exposure (brightness) of the whole
image in a way that prevents the color changes that can
occur when highlights become blown.

Brightness Adjusts the brightness of the whole image.  This control has most effect on the mid-
tones of the image.

Smart Contrast Increases or decreases the contrast of the whole image in such a way so as to bring
out the detail but leave the average brightness and color of the image unchanged.

Pressing the Smart Contrast button opens the following sub-sliders that provide
alternative contrast controls:

Contrast Adjusts the overall contrast of the whole image using
the standard simple technique.

Color Preserving
Contrast

Adjusts the overall contrast of the whole image in a way
that prevents color changes that the standard contrast
slider can introduce.

Vibrance Adjusts the overall vibrance of the whole image.  Increasing the vibrance will make
the colors in the picture more intense.  Decreasing the vibrance will make the colors
less intense (more gray).

Pressing the Vibrance button opens the following sub-slider that provides a similar
effect:

Saturation Adjusts the overall color saturation (color intensity) of
the whole image.  Vibrance and Saturation are similar
effects, the difference is that vibrance has less effect
than saturation on colors that are less intense.  Neither
slider affects areas that are black, white or gray.

Tone Curve Tone curves are used to change the brightness of an image in a way that allows
different amounts of change in areas that have different brightnesses.  The Tone
Curve slider is connected to several of the sub-sliders that combine to produce an
overall brightening effect when the slider is moved to the right, or a darkening effect if
the slider is moved to the left.

Pressing the Tone Curve button opens the following sub-sliders:
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Fix Flash Retrieve details in blown out highlights.

Highlights Increases or decreases the brightness of highlights.

Lights Increases or decreases the brightness of light areas.

Darks Increases or decreases the brightness of dark areas.

Shadows Increases or decreases the brightness of shadows.

Blacks Accentuates black areas.

Fill Shadows Brightens just the darker areas of the image, to bring
out detail in the shadow areas.

Vignette The vignette controls let you add a classic vignette effect over the image.

Vignette The main vignette slider controls the opacity of the
vignette effect.  If this is at 0, no vignette is applied.  At
100, the vignette effect will be opaque at the edges.

Radius Controls the radius of the oval used to create the
vignette effect.

Color Sets the color for the vignette.

Hardness Sets the size of the soft part of the vignette.

Horizontal Offset Moves the center of the vignette left and right.

Vertical Offset Moves the center of the vignette up and down.

3.2.13 Layers

PortraitPro lets you add extra image layers over your image.

PortraitPro also lets you make changes to the background, including replacing the background completely or
adding additional elements between the background and foreground parts of the image.

The background mask  identifies which parts of the image are background and which are foreground. 
PortraitPro will automatically create a background mask.  Tools are provided so that you can modify the
background mask as required.

Changing the background

To change the background of your image, press the Layers button to open the Layers section.

The Layers section will contain a sub-set of these buttons:
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Create Background Mask When you press this button, PortraitPro will automatically create
a mask and then switch to the Background controls, with the 
View/Edit Background Mask  controls section open.

This button is only shown if the background mask has not yet
been created.

View/Edit Background Mask Switches to the Background controls, with the View/Edit
Background Mask  controls section open.

This button is only shown if the background mask has been
created, or if the original image loaded had an alpha channel.

Change Background Switches to the Background controls, with the Change
Background  controls section open.

This button is only shown if the background mask has been
created, or if the original image loaded had an alpha channel.

Add Overlay Switches to the Overlay controls .

This button is only shown if no overlays have already been
added.

View/Edit Overlays Switches to the Overlay controls .

This button is only shown if one or more overlays have already
been added.

Before pressing the Create Background Mask button, you should make sure all the faces in the image have
been found, and the face outlines correctly shown around them.  Press the Other Faces button in the toolbar if
any faces have not been located properly.  This is necessary since PortraitPro needs to know the location of the
faces to make the initial background mask.

Don't spend much time adjusting the background mask initially.  Once the mask is roughly correct, press the 
Next button to open the other section, Change Background.

When the Background controls are shown, you can switch between the Background Mask  controls and the
Background Image  controls by clicking on the header for that section.

After you have changed the background image, go back to the Background Mask section and use the tools
there to refine the mask.

Note that the accuracy needed for the background mask depends greatly on the change made to the
background.  If the new background is very similar to the original background, then you usually don't need to be
very accurate with the background mask.  However, if the new background is very different from the original,
then a highly accurate mask will probably be needed.

Adding Overlays

Press the Add Overlay or View/Edit Overlays button (whichever is visible) to open the Overlays controls . 
You can use these controls to add image elements over your image.

A selection of overlay images is provided.  You can also select your own images.  For an image to be useful as
an overlay, it should normally have an alpha channel that sets part of the image to be transparent.
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3.2.13.1 View/Edit Background Mask

fIntroduction

The background mask covers the areas of the picture that contain the background.  This is the part of the
picture that will be affected by the background controls .

The controls and tools in the Edit Background Mask section let you set the background mask.

Most of the tools are in pairs, to let you set areas to be background or foreground.  Note that although you can
view and edit either the background or foreground, there is only one mask.  The foreground area is just the
inverse of the background and vice versa.

Getting Started

When you first enter the Edit Background Mask section, the background mask will have been automatically
created.  It will usually need to be adjusted to get a good result.

These are the recommended steps when adjusting a newly created mask:

· Use the fill tools to correct any large areas that are wrong.

These tools let you quickly fill large areas by scribbling over them.  The area filled automatically extends out
to edges detected in the picture.

· Press Next (at the bottom right of the controls panel) to open the Choose Background  controls, and set
the background that you want.

The reason for setting the background you want before getting the mask exactly right, is that the accuracy you
need will depend greatly on the change you are making to the background.  You can save a lot of time by only
fixing the areas that are visibly wrong.

· Press on the Background Mask section header to go back to the Edit Background Mask controls.

· Use the smart brush tools over areas near the edges of the mask that are wrong.

These tools try to automatically determine where the boundary between the background and foreground is
within the area painted, so they do not set the entire area painted to be background or foreground.

· Use the background and foreground tools if you have an area that the smart brushes do not work well on.

You can zoom in (using the zoom control ) and then use the background or foreground brush tools to
paint an area.

The other tools can be useful in certain cases.  For example, the Find Detail tool often works well for stray hairs
around the edges of the hair.

If you find colors bleeding through around the edges of the mask, this can sometimes be quickly fixed by using
one or more of the Adjust Whole Mask sliders.

Mask Tools

The buttons at the top of the controls panel provide 12 different tools that can be used to adjust the background
mask.

To use these tools, move the cursor over the image.  For most tools, a preview of the effect will be shown while
you move the mouse over the image.  Press and hold the left mouse button while moving the mouse over the
image to apply the tool to the mask.

The size of the brush can be adjusted using the Brush Size slider under the tool buttons.
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Some of the tools also have a strength setting.  When one of these tools is selected, a Strength slider will
appear under the Brush Size slider.

Fill Background Scribble in areas that should be background. This brush will
automatically fill out the area scribbled in.

Keyboard shortcut: S

Fill Foreground Scribble in areas that should be foreground. This brush will automatically
fill out the area scribbled in.

Keyboard shortcut: D

Smart Background Sets part of the area painted to background.  This tool tries to
automatically determine which areas should be set to background by
comparing the colors in nearby parts of the image that are foreground and
those that are background.

Keyboard shortcut: F

Smart Foreground Sets part of the area painted to foreground.  This tool tries to automatically
determine which areas should be set to foreground by comparing the
colors in nearby parts of the image that are foreground and those that are
background.

Keyboard shortcut: G

Background Sets the mask to background.

Keyboard shortcut: H

Foreground Sets the mask to foreground (i.e. not background).

Keyboard shortcut: J

Expand Background Makes the background area a little larger.  This only has an effect when it
is painted over an edge in the mask.  The edge will be moved towards the
foreground area to make the background area larger.

Keyboard shortcut: K

Expand Foreground Makes the foreground area a little larger.  This only has an effect when it
is painted over an edge in the mask.  The edge will be moved towards the
background area to make the foreground area larger.

Keyboard shortcut: L

Soften Mask Edge Blurs the mask edge.  This tool only has an effect if it is painted over an
edge in the mask.  It can be useful if you don't want a hard edge where the
new background starts.

Sharpen Mask Edge Sharpens the mask edge.  This tool also only has an effect if it is painted
over an edge in the mask.
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Find Hard Edges This tool can be used to align a mask edge with a hard edge in the
original image.  This tool only has an effect if it is painted over an edge in
the mask.  It should be used where the original image has a hard edge,
and you want the mask edge to be aligned with that edge.  Start by getting
the mask roughly right using the other tools, then use this Find Hard
Edges tool to align the mask edge exactly with the edge in the original
image.

Find Detail This tool should be used in areas that have lots of fine detail.  It tries to
automatically set both the foreground and background in the area painted
over.  This tool is effectively a combination of the Smart Foreground and
Smart Background tools.

Mask Views

When editing the mask, it can be viewed in a number of ways to make it easier to see what you are doing.

The view mode can be selected by clicking on one of the buttons that shows a small image of how the mask
will be shown when that mode is selected.

As you hover over each button, the name of the mode is shown above the buttons.

Show Result This is generally the most useful view, since it shows exactly what you will
get when you have finished.  It shows how the new background will
appear on the original image.

Keyboard shortcut: 1 (6 for left hand view)

Show Foreground Only This shows the foreground of the original image, with the background
shown as a checkerboard.  This view shows exactly which parts of the
original image will be unchanged when the background is replaced.

Keyboard shortcut: 2 (7 for left hand view)

Show Background Only This shows the background of the original image, with the foreground
shown as a checkerboard.  This view can be useful to see if parts of the
original image that you want to be in the foreground are currently part of
the background.

Keyboard shortcut: 3 (8 for left hand view)

Show Mask Overlay This shows the original image with the background mask overlaid as a
semi-transparent color.  The color used for the overlay can be selected
from the drop down list.

Keyboard shortcut: 4 (9 for left hand view)

Show Mask Only This shows just the mask.  The background is shown as white, and the
foreground as black.

Keyboard shortcut: 5 (0 for left hand view)

It can sometimes be useful to see more than one view of the mask at once.  This can be done by selecting the 
Dual Views tab above the image, which shows two views side by side.  When this tab is selected, two sets of
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mask view mode buttons are shown in the controls panel, so that a different view mode can be set in the left
and right views.

When you first view a newly created background mask, the left view will be set to Show Background Only, and
the right view to Show Foreground Only.  This is because the Show Result view is not useful before any
changes have been made to the background image.

When you return to view an existing background mask, the left view will default to Show Background Only, and
the right view to Show Result.  However, if you have changed these view options, these will be remembered
when you return.

Adjust Whole Mask

At the bottom of the controls panel, there are three sliders that can be used to quickly make changes to the
whole mask.

Note that these sliders all affect just the edges of the mask.

Blur/Sharpen Move this slider to the left to blur all the edges in the mask.  Move this
slider to the right to sharpen all the edges in the mask.

Grow/Shrink Move this slider to the left to grow the background mask (shrinking the
foreground).  Move this slider to the right to shrink the background mask
(growing the foreground).

Shift Edge Move this slider to the left to move the mask edges inwards.  Move this
slider to the right to move the mask edges outwards.

Keyboard shortcuts

CTRL While held, temporarily switches to pan tool.  This lets you move the image
in the view.

SHIFT While held, temporarily switches to the opposite tool.  This switches from
a tool affecting the background to the one performing the same operation
on the foreground and vice versa.  Also switches between the soften mask
and sharpen mask tools.

S, D, F, G, H, J, K, L Switches the current tool.  The descriptions of the tools above show which
shortcut is for which tool.

1, 2, 3, 4, 5 Changes how the mask is shown.  The descriptions of the mask views
above show which shortcut is for which view mode.

If the Dual Views tab is selected, these keys affect the right view.

6, 7, 8, 9, 0 Changes how the mask in the left view is shown.  These keys only have an
effect if the Dual Views tab is selected.

[, ] Make the brush size smaller or larger.
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3.2.13.2 Change Background

The controls in this stage let you select what you want to do to the background areas.

The background image can be changed in two ways:

· Additional layers can be added between the background from the original image and the foreground from the
original image.

· Sliders can be used to apply effects such as blurring to the background image.

Adding layers

The three buttons at the top of the Background Image controls let you add the following types of layer:

Flat Color Adds a layer that fills the entire background area with a flat color.

The color to use can be set using the color selector control.

There is also an opacity slider that lets you fade out the color layer.  Set
this slider to 100 if you want to flat color to be opaque, which will
completely hide any layers below it, including the background from the
original image.

Color Gradient Adds a layer that fills the entire background area with a color gradient.

The gradient is set by two colors and two positions within the image.  The
colors are set using the color selector controls.  The positions of these
two colors are shown by circles in the image, which can be dragged to
move the color gradient.

When dragging the color positions in the image, they will snap to various
positions such as the edges of the original image, or when they are
vertically, horizontally or diagonally aligned.  To turn off the snap, hold
down the ALT key while dragging.

There is also an opacity slider that lets you fade out the gradient color
layer.  Set this slider to 100 if you want to flat color to be opaque, which
will completely hide any layers below it, including the background from
the original image.

Background Image Adds a new image layer.

Press the Select Image button to bring up a file dialog that lets you
choose the new image.  If Open Built-in Backgrounds Folder is checked,
then the file dialog will open in the application folder that contains a
selection of backgrounds that are provided with PortraitPro.  Otherwise,
the file dialog will open in the last folder you chose a file from.

Once the new image is loaded, you can position it in the image.  A
rectangle is shown around the new image.  Drag within the rectangle to
move it, or drag a corner or edge to resize it.  You can also rotate the
image by dragging outside the rectangle.
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When dragging to reposition the image, it will snap to various positions to
help you align it accurately.  To turn off the snap, hold down the ALT key
while dragging.

There is also an opacity slider that lets you fade out the image layer.

Press the Set Crop To This Image button to set the crop rectangle to the
current bounds of this image.  Note that if you subsequently move the
image, the crop rectangle will not be updated so you will need to press
this button again if you want to also adjust the crop.

Viewing and Editing Layers

New layers are always added above any layers that have already been added.  The first layer is added above
the original image.

The layers added are shown in the Background Layers section below the buttons.  Click on one of the layers to
open the controls it contains, that allow it to be edited.

Layers can be re-ordered by pressing the up and down arrows in the header bar for each layer.  The
background from the original image must always be the lowest layer.

Layers can be deleted by pressing the X in the header bar.

Adjust Background

The whole background, consisting of all the background layers composited together, can be adjusted using the
Adjust Background sliders.

Blur Blurs the background area.

If a blur is applied, then the Depth of Field slider becomes enabled, which
can be used to simulate a depth of field effect.  If the Depth of Field slider
is 0, then no depth of field effect is applied.

The depth of field effect uses the simple assumption that the background
is a flat plane receding into the distance.  To simulate a focus point and
depth of field, a horizontal line along the background is left un-blurred,
and the blur increased either side of this until it reaches the blur amount
set by the Blur slider.  The Depth of Field slider controls the size of the un-
blurred area (simulating the depth of field of a lens).

If the Depth of Field slider is greater than zero, then the Focus Plane
Position slider becomes enabled, and it can be used to set the height at
which the un-blurred line is set, which simulates the distance into the
scene that the focus point is set.

Brightness Brightens or darkens the background area.

Contrast Increases or decreases the contrast of the background area.
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Exposure Increase or decreases the exposure of the background area.

Flash Recovery Reduces the brightness of very bright areas that might have been over
exposed by a flash.

Blacks Decreases the brightness of dark areas to enhance the black area in the
image.

Tone Curves Open the Tone Curves section to show sliders that let you selectively
adjust the brightness of different parts of the image based on their
brightness.

Temperature Adjusts the color temperature of the background.  Move the slider left to
reduce the color temperature (making it more blue) or to the right to
increase the color temperature (making it more yellow).

Tint Adjusts the color tint of the background.  Move the slider to the left to make
the image more magenta, or to the right to make it more green.

Adjust Foreground

Most of the sliders available in the Adjust Background section are also available for adjusting the foreground
image.  This is the part of the original image that is not part of the background.

3.2.13.3 Overlays

PortraitPro allows you to add overlay images to your image.

These are added after all other effects and processing, so will not be affected by any other sliders.

To add an overlay:

· Press the Layers  button to open the Layers controls

· Press the Add Overlay button to switch to the View/Edit Overlay controls

· Press the Add Overlay Image Layer button to add an overlay image

· Press the Select Image button to bring up the dialog where you can select an image

Once you have added an image, you can move. rotate and resize it by dragging the control points in the main
view.

Layers can be re-ordered and deleted in the same way as the layers in the Background Image  controls.

3.2.14 Skin Area Tools

PortraitPro automatically determines which areas of the picture are skin. This is the area that will be affected by
the skin smoothing and skin lighting sliders. For some pictures, PortraitPro may not get the skin area exactly
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right, so you should always check the skin area and fix it if necessary.

To check and fix the skin area, click the View/Edit Skin Area button which is at the top of each of the sections
that contain sliders that enhance the skin area.  These sections are: Skin Smoothing  and Skin Lighting &
Coloring .

This will switch to the skin area selection tools.  The skin area will be shown by default as a translucent blue
overlay over the enhanced image. If this color does not make it easy to see the skin area in your picture, you
can choose another color from the Color drop down list.

If the skin area is wrong, manually adjust it using the Skin Area Brushes .

You can also get PortraitPro to recalculate the skin area by clicking on the Recalculate Skin Area button.

Press the OK button to return to the slider controls.

3.2.15 Hair Area Tools

PortraitPro automatically finds the area in the image that is hair. This is the area that will be affected by the hair
sliders. It is important to get this area fairly accurate otherwise the hair sliders will not work as well as they can.

To check and fix the hair area:

Press the Show Hair Controls button to open the Hair  section.

Click on the View/Edit Hair Area button at the top of the Hair Controls. This will switch to the hair area selection
tools. The hair area will be shown as a colored overlay over the enhanced image. If the automatic color does
not make it easy to see the hair area in your picture, you can choose another color or adjust the opacity using
the drop down lists.
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If the hair area is wrong, manually adjust it using the Hair Area Brushes .

Press the OK button to return to the hair controls.

3.2.16 Effects Mask Tools

The effects mask allows you to set areas where effects will be applied.  This can be useful to prevent effects
such as skin smoothing or makeup being applied to areas of the face that are obscured.

Please note that shape changes due to changes in the Face Sculpt  section ignore the effects mask.

To view or edit the effects mask, hover over the Restore  brush button in the toolbar above the main view,
and then click View/Edit Effects Mask to switch to the Effects Mask brush tools .

3.3 Dialogs Reference

This section describes the dialogs in PortraitPro.

Automatic Batch Save Options Studio Max Edition Only  Options when using automatic batch
processing

Manual Batch Studio Edition Only  Controls for using manual batch processing

Select Gender Manual selection of gender and age of a face

Save Image Options Options when saving image as JPEG, TIFF or PNG
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General Settings Settings that control various parts of PortraitPro

Color Settings Color Profile settings (Studio edition only)

Language Settings User interface language setting (Multi-lingual versions only).

Save Sliders Used to save the current slider values.

Manage Saved Sliders Manage the Saved Sliders settings (rename, re-order, or delete).

3.3.1 Automatic Batch

Studio Max Edition Only

This dialog appears when you start a new automatic batch .

You can also bring it up after a batch has started:

· Select the Change Settings menu command from the Auto Batch menu.

· Click the Change Settings button in the control panel when viewing the automatic batch summary.
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Auto Save

If this check-box is checked, then each image will be saved automatically after it has been enhanced.  The
enhanced image will be saved to the folder set in the Save Folder section, and with the named set in the
Enhanced Image Filename section.

If it is not checked, then the images will be enhanced, but won't be saved out automatically.  This can be useful
if you want just a few of the images loaded to be saved.  To do this, make sure this check-box is not checked
when you first load all the images.  You can then review all the image and remove those that you don't want. 
The bring up this panel again and check this box.

Save Folder

The folder where the enhanced images are saved can either be specified exactly, or you can make it a
subfolder of the folder where the original image is stored.

To save to the same folder as the original image, select Save to Subfolder of Source Folder and clear the text
box next to that option.  However, note that PortraitPro will not allow the original image to be overwritten by the
enhanced image, so if you set this option, you must also enter either a prefix or suffix in the next section.
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Enhanced Image Filename

The enhanced images will be saved with the same filename as the original image unless some text is entered
in the prefix or suffix boxes.

If the prefix box is not empty, this is added to the start of the filename.

If the suffix box is not empty, this is added to the end of the filename.

Saved Image Type

Press the Change button to select the file format to use when saving the enhanced images.

Gender/Age of All Faces

This should usually be left on automatic for both gender and age.  However, if you know that all the faces in all
the images have the same gender or are all in the same age category, then you can set this here to avoid the
risk of the automatic gender finder or age finder getting it wrong.

Apply Presets

Use the drop-down controls to select which preset to apply to each female, each male and each child face that
is enhanced.

You can select a face in the film strip view  after it has been processed to view it in the enhanced face
stage , and then change the preset applied if you want different presets for different faces.

3.3.2 Manual Batch

Studio Edition Only

To bring up this dialog, select File > Open Batch... menu command.
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This dialog lets you set up a list of files to work through. You can also set the save options to use when each
file is saved.

Adding Files

To add files to the batch list, press the Add Files button. This brings up a file open dialog that you can use to
select the files to add.

The files in the batch are shown in the list at the top of the dialog.

Using the Batch List

When you press the OK button, your changes are saved and the first file in the list that has not already been
completed will be opened.

When you have finished enhancing that image, select the Save And Open Next command from the File
menu. This will save the current image using the options selected, and then automatically open the next file in
the list.

If you open the Batch dialog again, you will see a check against the file you have just completed.

The following icons can appear next to the files in the list:

Pending - file is waiting to be processed

30
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Completed - file has been enhanced and saved

Failed - file could not be opened

Skipped - file was closed without saving

You can reset a file's status back to "pending" by right clicking on the file, and selecting Reset Status from the
pop-up menu.

Once you have completed all the files in the batch, press the Remove Completed button to remove them from
the list.

The files in the batch and the batch settings are saved when PortraitPro is closed, so you can carry on working
on the files in the batch the next time you run PortraitPro.

Reorganizing the Files

The files will be opened in the order shown in this list. If you want to re-order the files, select one or more files
in the list and press the Move Up or Move Down button.

You can also remove the selected items by pressing the Remove button. Note that this only removes the files
from the list, it does not delete the files from the disk.

To select more than one file in the list, hold down the CTRL key when selecting another file. Alternatively, you
can hold down the SHIFT key to add all files between the current file and the one clicked on.

Save Options

Files are saved in the format shown in the Save Options section. Press the Change button to bring up a dialog
that lets you change the save format.

If you check the Also Save Session box, then a PortraitPro session file (.pp extension) will also be saved, which
will save the image along with all the point positions and all the slider values. You can open a session file to
continue enhancing an image without having to position the face points again. The session file will be saved in
the same folder and with the same name as the enhanced image, but it will have a .pp extension.

The files will be saved to the same folder as the original file if Save to Same Folder As Original File is checked.
If you want to save the enhanced images to a different folder, uncheck the box and enter a path in the Folder
Path field. You can press the Browse button to bring up a folder dialog that lets you select a folder to save to.

The enhanced image will be saved to a file with the same name as the original file. If you have specified a suffix
to add in the File Save Settings , this will also be added.80
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3.3.3 Select Gender

This dialog appears when the gender and age of a face has not been set.

Press the Female or Male buttons to set the gender (or Child if the face is of a young child).  This will dismiss
the panel and let PortraitPro continue to the next step.

Press the Cancel button if you do not want to set the gender, and this will return to the previous step.

If the dialog was shown automatically when a single face was detected, it will also have the Discard Outlines
button, in case the face was not detected properly.

This dialog can appear at the following times:

· After loading an image , when one face has been found.

· When pressing the Select button on a face at the Select Face  stage, if the gender for that face is not
already set.

3.3.4 Save Image Options

When you save an image using the File > Save Jpg/Tiff/Png menu command, the Save Image Options dialog
will appear.

14

18



Reference 79

© 2018 Anthropics Technology Ltd.

This lets you select whether you want to save the image as a JPEG, TIFF or PNG file.

JPEG Format

If you select JPEG, you can control the quality of the image saved. The advantage of choosing a lower quality is
that the file size can be much smaller. JPEG is usually the best option if you don't plan to do any more editing of
the image after you have saved it.

TIFF Format

Saving an image as a TIFF will usually result in a larger file than saving it as a JPEG. However, TIFF stores the
exact image, there is never any loss in quality. This is the best option if you plan to open the image to edit
further in another image editor.

TIFF images can be stored either uncompressed or losslessly compressed. The recommended setting is for
compressed, because the only reason for not selecting this would be if you wanted to open the TIFF file in
another application that did not support compressed TIFFs (although it is unlikely any modern software would
not support this format).

PNG  Format

PNG is another format that uses lossless compression.

Bits Per Color Sample setting

Studio & Studio Max Editions Only

TIFFs and PNGs can store either 8 or 16 bits per color sample (which is 24 or 48 bits per pixel respectively).  If
you can see artefacts such as banding in the enhanced image, this can usually be fixed by using 16 bits per
color sample instead of 8.  However, using 16 bits per color samples will generally double the file size
compared with 8.  Also, not all programs can read images with 16 bits per color sample.

3.3.5 Settings

To bring up this dialog, select File > Settings menu command.

General General Settings

Color Color Settings
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Language Language Settings

Plugin Lets you install the Photoshop filter plug-in that lets PortraitPro be used as a filter
from Photoshop.

3.3.5.1 General Settings

To bring up this dialog, select File > Settings menu command.
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File Save Settings

Don't Save Over Original Image File - check this box and when saving a picture PortraitPro will create a default
filename that is different from the original file name.

Add Suffix to Image Filename - with the above option turned on, the new filename for saved files will be the
same as the old filename with the text here added to it. By the default the suffix added is "_pp" so for example, if
a file called picture.jpg is loaded, then the default saved file would be picture_pp.jpg

Recent Files Settings

Don't Save List Of Recent Files When Application Closed - check this box and no history of files opened will be
saved when the application is closed.

User Interface Settings

Use Dark User Interface Style - check this box to use a dark color scheme, or uncheck this box for a more
conventional Windows style.

Automatically Find Faces In Images - check this box to have faces automatically found in images when they
are opened.  If this box is unchecked, you will need to manually locate all faces in your images before they can
be enhanced.

Automatically Find Gender/Age - check this box to have the gender and age (adult or child) automatically
determined for all faces that are found in an image when it is opened.  If this box is unchecked, you will need to
manually select the gender and age for each face before it can be enhanced.

Show Label by Cursor When Locating Feature Points - check this box and when placing the main 5 points on
the face, the cursor will have extra text next to the points to help you.

Skip Zoomed In Steps When Adjusting Outlines - check this box to skip the steps where the image is zoomed
in to the left eye, right eye, and nose & mouth after the first 5 points have been located.  Note: this does not
affect profile views (where the face is side on).

Use Point Position Constraints - check this box to force some points to lie along particular lines when they are
being moved.  This can help prevent points from being positioned in the wrong place, although experienced
users may get better results if this is turned off.

Ask If Mouth Closed When Adjusting Mouth Outline - check this box and when adjusting the points on the
mouth PortraitPro will prompt you with a question about whether the mouth is open or closed. Note that even
with this option on, you can press the spacebar to select that the mouth is open and move on to the stage of
actually moving the mouth points. After doing this, if the mouth really is closed, just move the lip points together
and they will merge to form a closed mouth shape.

Show Tool Tips - uncheck this box to turn off all the tool tips (the pop-up help that appears when you hover the
mouse over a control).

Updates Settings

Automatically Check for Updates - if this is checked, then PortraitPro will periodically check to see if a new
version of PortraitPro is available.  If an update is available, a button will be shown on the Welcome screen. 
When you click the update button, your web browser will be opened showing information about the update that
is available.
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3.3.5.2 Color Settings

Studio & Studio Max Editions Only

To bring up this dialog, select File > Settings menu command and the Color tab.

Color management helps to ensure that the colors you see on your monitor are as close to how they should
appear as possible.

In addition, you can configure what working color profile PortraitPro Studio uses internally. This affects the color
gamut, which is the range of colors that can be represented.

For maximum speed, select the "High Performance" option. This allows PortraitPro Studio to optimize the use
of color profiles for the screen when being used interactively. Regardless of this setting, your chosen working
profile will be used when saving files.

9
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You can also configure the color depth used by PortraitPro Studio. This is the number of bits used to represent
each color sample.

Each pixel consists of 3 color samples (red, green and blue), so:

· 8 bits per color sample is 24 bits per pixel.

· 16 bits per color sample is 48 bits per pixel.

Note: this dialog is only available in the Studio editions of PortraitPro. The standard edition of PortraitPro works
with Color Management turned off and 8 bits per color sample. What this means is that colors displayed on the
screen may not be accurate, however color profiles are preserved which means that the images saved from
PortraitPro will have the same color profiles as the images that were originally loaded. If using these images in
other color managed programs the colors will look correct.

An explanation of color management

When color management is turned on, PortraitPro will ensure that the colors on the screen are correctly
displayed according to the color profile specified in the image and your monitor profile. For the very best results,
calibrate your monitor rather than using the profile that is provided by the manufacturer of the monitor.

For example, if you have a picture on your disk that you have saved with an sRGB profile and you also have the
same picture saved with an Adobe (1998) profile, then they will be displayed with slightly different colors with
color management turned off, but when color management is on they will look the same. In fact with color
management on the two pictures could still look slightly different due to out of gamut colors being lost when the
images were created, or rounding errors caused by the different color profile conversions in the process of
displaying the images. However any changes would be very slight and normally not noticeable.

If you print a lot then a good rule of thumb is to use Adobe (1998) as your working profile, or if you mainly view
images on your monitor then sRGB is more suitable. In either case it is best not to convert from one color
profile to another without a reason, because during the conversion there may be colors that become out of
gamut (i.e. they cannot be represented in the new color space) and so they will be lost, and also rounding
errors could be introduced which would appear as color banding over smooth gradients in the image.
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3.3.5.3 Language Settings

To bring up this dialog, select the File > Settings menu command and choose the Language tab.

If you select the option Automatic, the language will be automatically set to the same as the language of your
computer if that language is supported, otherwise English will be selected.

3.3.5.4 Plugin

Studio & Studio Max Editions Only

To bring up this dialog, select File > Settings menu command and the Plugin tab.

9
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This dialog lets you install the plug-in filter that makes PortraitPro available in Photoshop.

You will have been offered the option to install the plug-in when PortraitPro was installed. This panel lets you
re-run the plug-in installer. This lets you install the plug-in if you chose not to install it when PortraitPro was
installed, or if you have since installed a new version of Photoshop.

The plug-in installer will automatically detect which version(s) of Photoshop you have installed. You just need to
check the box next to each application that has been detected to install the plug-in for that application.

You will also be offered the option to select a folder into which to install the plug-in. This is useful if you want to
install the plug-in for other applications that you know are compatible, or if you have an install of Photoshop that
was not detected automatically for some reason.
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Plug-in Mode Settings

Auto Plug-in Mode - If this is checked, PortraitPro will enter plug-in mode  if a path is specified on the
command line when launching the application.

3.3.6 Save Preset

To bring up this dialog, press the Save Preset button in the Presets Controls .

Enter a name, and when you press OK the current slider values will be saved with the other presets.

If you enter the name of an existing preset, it will be replaced.

If you also want to assign this preset to a particular age or gender category, then check the appropriate box
before pressing OK.

By default, all slider values are saved. If you want to save just a subset of the sliders, such as Makeup or Skin
Smoothing, choose that type from the drop down menu.
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Click in the checkbox next to each slider to toggle between saved (checked) and not saved (unchecked).

If you click in the checkbox of a slider that has sub-sliders, all the sub-sliders will be set to the same.
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3.3.7 Manage Presets

To bring up this dialog, press the MANAGE button in the Presets  Controls.

This dialog shows all the presets. These can be filtered using the dropdown menu to show presets for
particular sections of the picture.

To rename a preset, double click it's name in the list, then type the new name.

To re-order the presets, you can drag them to new positions in the list.

To delete a preset, click on the one you want to delete so that it is highlighted and then press the Delete button.

To set a preset as the initial values to use when a new face is loaded, click on the one you want, then click Set
Defaults. A menu will open allowing you to check which faces this should be set as default for.

To delete all of your presets click Reset All Presets. To delete only the presets in the current section, click
Reset This Section Only. When you click OK to close the Presets dialogue, you will be asked to confirm this.
Click OK to confirm or Cancel to go back to the presets menu. To continue without deleting the presets, close
the Preset dialogue by clicking Cancel.
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3.4 Tools Reference

This section describes the tools available in PortraitPro.

These tools are available when enhancing an image , and work in the enhanced ("After") image view.

When you change tool, you change what will happen if you click in the enhanced image view.

Each tool has a different cursor shape, so that you can easily see which tool is selected.

Pan Tool Pans the view of the image. This is the default tool if no other tool is selected.

Brush Tools Let you paint in the enhanced image to touch-up or restore spots.

Area Brush Tools Let you paint in the enhanced image to refine the skin or hair areas.

Crop Tool Used to crop the picture.

3.4.1 Pan Tool

The Pan tool is available when you are enhancing an image .

The Pan tool is the default tool when no other tool is selected.

To use the Pan tool, click and drag the image to change which part of the image is visible.

When the Pan tool is selected, you can use your mouse wheel or the + and - keys on your keyboard to zoom.

The Pan tool can be used as an alternative to the Zoom Control Window.

3.4.2 Brush Tools

The brush tools are available when you are enhancing an image .  They are called brush tools since they
work like a paintbrush.  You need to move the cursor over the area where you want to "paint" with the brush,
then press and hold the left mouse button while you drag the mouse over the area you want to affect.

There are two types of brush tools.  This page describes the standard brush tools which are used for making
changes to how the skin is enhanced in particular areas.  The other type is the Area Brush Tools , which are
used for selecting the areas where the skin and hair enhancements are made.

Touch-up and Restore Brushes

The following brushes are available from the bar above the main image view.

Touch-Up Brush Use this to paint over spots or blemishes in the skin that have not been
eliminated automatically or which need further correction.

When you hover over the touch-up brush button, a controls panel pops up that
contains sliders that let you change the size and strength of the touch-up brush.
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Restore Brush Use this to paint over spots in the skin that have been removed, but that you
would like to bring back.

When you hover over the restore brush button, a controls panel pops up that
contains sliders that let you change the size and strength of the restore brush.  It
also contains a button that lets you view or edit the effects mask .

Brush Controls

To select a brush, press the appropriate button.

Press the button again to deselect the brush (goes back to the Pan tool ).

The brush tools work like a paintbrush. You use them to paint an area on the enhanced image, to which the
brush effect is applied.

To use a brush, press the mouse left button while the cursor is in the enhanced image, and drag the mouse
while holding the button down. Release the mouse button to finish the brush stroke. The area that the cursor
passes over while you do this is the area that you have "brushed". 

Brush Size

The brush size controls how big an area is affected by the brush. You can see how big this area is from the size
of the cursor circle when using the brush.

Brush Strength

The brush strength (opacity) controls how strongly the brush effect is drawn. A strength of 100 means the full
brush effect is applied in one stroke. You can set a smaller strength to make gradual changes. 

For example, if you set the strength to 50 when using the Touch-Up Brush, then when you paint over a spot only
half of the maximum spot removal effect will be applied. If you release the mouse and paint over the spot again,
then 50% more spot removal processing will be applied. This lets you do just enough to remove the spot, but
without applying too much effect which might over-blur the surrounding area.

When a brush tool is selected, controls to set the brush size and strength will appear near the button used to
select it. You can also adjust the opacity using the numbers 1 to 9 on your keyboard.

Brush Undo

When you use any brush tool, the last brush stroke can be undone using the Edit Menu  Undo command, or
by pressing Control-Z on the keyboard. Further undo will undo previous brush strokes and other actions that
you have performed going back in the history of the current session. After an undo you can also redo to get back
where you were from the Edit Menu  Redo command or Control-Y.

Tablet Support

PortraitPro supports a tablet and stylus. If you have a tablet and stylus you will normally find this easier to use
when drawing.

3.4.3 Area Brush Tools

The area brush tools are available when you are enhancing an image .  The area brush tools are used to
adjust the areas where the skin or hair enhancements are made.  They can also be used to define an effects
mask that can be used to prevent any effects being applied in particular areas.  PortraitPro will automatically
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select the skin and hair areas, but depending on the picture it may not always get these areas exactly right.  The
area brush tools are provided to let you manually fix these areas.

The three types of areas that can be edited using brushes are:

Skin area To view or edit the skin area, by open the Skin Smoothing  or Skin Lighting &
Coloring  section, and then press the View/Edit Skin Mask button.

The skin area is used when applying skin effects to the picture.

Hair area To view or edit the hair area, open the Hair  section, and then press the View/Edit
Hair Mask button.

The hair area is used when applying hair effects to the picture.

Effects mask To view or edit the effects mask, hover over the Restore brush  button in the
toolbar, and then press the View/Edit Effects Mask button.

Cut away areas of the effects mask to prevent any effects being applied to those parts
of the picture.

The area brush tools are "smart" brushes, in that they will automatically detect the edges of regions.

You will see when you select an area brush tool that the position of the brush is shown by two circles.  The
outer circle is the area where the brush will be applied.  The inner area is the "detector" region.  When you paint
with the brush, the detector region is painted as normal.  The region between the inner circle and the outer
circle will only be painted for areas which are a similar color to the color in the inner region.  This means that if
you are painting along an edge, all you need to do is keep the detector region completely inside the area you
are painting, and the brush will automatically paint up to the edge but not beyond it, even if the outer circle of the
brush goes beyond the edge.

When painting with a smart area brush, you can press and hold the ALT key to lock the position of the detector.
This is very useful when painting very fine detail such as strands of hair.

Brush Tools

There are two types of brush tool:

Extend Use this to paint over areas that you want to add to the mask.

Cut Back Use this to paint over areas of the photo that you want to remove from the mask.

3.4.4 Crop Tool

The Crop tool is available when you are enhancing an image .

To select the Crop tool, press the Crop tool button in the Picture Controls  section.

The Crop tool is used to adjust which area of the whole picture you are going to use for your portrait. You may
need to do this to cut out distractions, so that the portrait focuses on the person in the picture. When you crop
you don’t actually lose anything from the picture, you just change the area displayed and you can always come
back and re-adjust the crop if you have got it wrong.
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Upon opening the tool, the crop grid will be overlaid on your picture.

This grid shows the part of the picture that will be displayed, divided into thirds for reference.  Adjust the grid by
clicking and holding on any point on the grid and dragging it to the position you want.

Once you are happy with the way the crop looks, click on Commit to make the changes. If you want to cancel the
changes you have just made, click on Discard.

TIP: Professional photographers will usually place the eyes or the mouth in a portrait on the "third" lines. This
gives a more pleasing balance to the picture.

You can also fix the aspect ratio of the crop using the Fix Aspect Ratio function in the crop control panel.  For
example you may want to print out a 6x9 inch picture (this is a standard photographic print size), so want to
work in this aspect ratio.  To do this set the Fix Aspect Ratio values by clicking in the To: and By: boxes and
entering the ratio you want. Once you have done this the crop grid will automatically stay in the that ratio as you
drag it around.
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3.5 Plug-in Installation Guide

Studio & Studio Max Editions Only

Installing the PortraitPro Photoshop Plug-in

In the Studio & Studio Max editions of PortraitPro, you have the option to use PortraitPro as a plug-in  from
Photoshop and other compatible photo editing suites.

This option is available to install on the Installation Complete screen of the Studio & Studio Max editions.

To begin the plug-in installation, click Finish on the Installation Complete screen with the Launch Photoshop
Plug-in Installer check-box checked.  

The installer will be signed by Anthropics Technology Ltd.  Select Continue to progress to the installer.  

The language select screen will appear. Select your language and click OK to continue.  

The Welcome Screen will appear, click Next > to move onto the next screen.  

The Select Install Location screen lets you select the programs you want the plug-in to be installed into.  The
installer will automatically detect installed software that is compatible with the plug-in and display it.  Check the
detected software boxes to install the plug-in for that program.  You can also manually select the installation
path by checking the Choose Install Path Manually box, which will allow you to install the plug-in to a specific
folder.  Once you have selected the options you require, click Next > to progress to the next screen.  

If you selected Choose Install Path Manually in the Select Install Location screen, you will be taken to the
Plug-in Destination Folder screen.  You will be able to select the folder of any supported program that the plug-
in has not automatically detected.  Click Browse and select the plug-in folder of the program that you would like
the PortraitPro plug-in installed to.  Then click Next >.  

On this screen you are prompted to select the version of the plug-in you want to be installed.  The version
should match the program you are installing the plug-in into.  For 32-bit applications, select the 32-bit plug-in
and the 64-bit plug-in for 64-bit applications.  When you have made your selection, click Next >.

Clicking Install on this screen will install the PortraitPro plug-in into the chosen programs.

(Note: The plug-in can be installed from PortraitPro at any time under File> Settings > Plug-in > Run Plug-in
Installer).

Re-installing plug-ins

If you did not install the plug-ins when PortraitPro was installed, perhaps because you did not have the other
application already installed at that time, you can install the plug-in later.

To do this, go the Plugin Settings  dialog, from where you can re-run the plugins installer.

Troubleshooting

If the PortraitPro plug-in does not appear in Photoshop (or other compatible application), it may not have
installed correctly.  This can be caused by the plug-in being installed into the wrong folder.

To fix this, you need to find the correct folder for the plug-in to be installed into.  Usually, the plug-in install
location is "C:\Program Files\<APPLICATION-NAME>\Plug-ins" for example, "C:\Program Files\Adobe
Photoshop CC\Plug-ins\".  Once you have found the correct folder, run the plug-in Installer from the Plugin
Settings  dialog, and select the "Choose Install Path Manually" option.
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3.6 Third Party Credits

PortraitPro uses a number of third-party libraries, which are acknowledged here.  We offer our thanks to the
authors for providing these valuable resources.

dcraw

RAW image reading is provided by dcraw.

Copyright 1997-2012 by Dave Coffin, dcoffin a cybercom o net

tifflib

TIFF image reading and writing is provided by libtiff.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its
documentation for any purpose is hereby granted without fee, provided that (i) the
above copyright notices and this permission notice appear in all copies of the
software and related documentation, and (ii) the names of Sam Leffler and Silicon
Graphics may not be used in any advertising or publicity relating to the software
without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE.  

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY
OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE
USE OR PERFORMANCE OF THIS SOFTWARE.

jpeglib

JPEG image reading and writing is provided by jpegtiff.

This software is based in part on the work of the Independent JPEG Group.

This software is copyright (C) 1991-2011, Thomas G. Lane, Guido Vollbeding.

pnglib

PNG image reading and writing is provided by pnglib.

zlib

Zlib compression support is provided by zlib.

(C) 1995-2012 Jean-loup Gailly and Mark Adler

http://www.cybercom.net/~dcoffin/dcraw/
http://www.libtiff.org/
http://www.ijg.org/
http://www.libpng.org/pub/png/libpng.html
http://www.zlib.net/
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Adobe DNG SDK

DNG reading is provided by the Adobe DNG SDK.

Lossless JPEG code adapted from:

Copyright (C) 1991, 1992, Thomas G. Lane.
Part of the Independent JPEG Group's software.

Copyright (c) 1993 Brian C. Smith, 
The Regents of the University of California
All rights reserved.

Copyright (c) 1994 Kongji Huang and Brian C. Smith. 
Cornell University
All rights reserved.

Permission to use, copy, modify, and distribute this software and its documentation
for any purpose, without fee, and without written agreement is hereby granted,
provided that the above copyright notice and the following two paragraphs appear in
all copies of this software.

IN NO EVENT SHALL CORNELL UNIVERSITY BE LIABLE TO ANY PARTY FOR DIRECT, INDIRECT,
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF THIS SOFTWARE
AND ITS DOCUMENTATION, EVEN IF CORNELL UNIVERSITY HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE. 

CORNELL UNIVERSITY SPECIFICALLY DISCLAIMS ANY WARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
THE SOFTWARE PROVIDED HEREUNDER IS ON AN "AS IS" BASIS, AND CORNELL UNIVERSITY HAS NO
OBLIGATION TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR MODIFICATIONS.

Copyright © 2006 Adobe Systems Incorporated. All rights reserved.

Adobe is a registered trademark or trademark of Adobe Systems Incorporated in the
United States and/or other countries. Windows is either a registered trademark or a
trademark of Microsoft Corporation in The United States and/or other countries. Mac is
a trademark of Apple Computer, Inc., registered in the United States and other
countries. All trademarks noted herein are the property of their respective owners.

Adobe XMP SDK

The Adobe XMP SDK is used by the Adobe DNG SDK

Copyright 2009 Adobe Systems Incorporated and others.  All rights reserved.  The
original version of this source code may be found at http://adobe.com.

lcms library

ICC color profile handling is provided by lcms.

Little CMS

Copyright (c) 1998-2007 Marti Maria Saguer

Permission is hereby granted, free of charge, to any person obtaining a copy of this
software and associated documentation files (the "Software"), to deal in the Software
without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to

http://adobe.com
http://www.littlecms.com/
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permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies
or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE
OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

OpenCV

Automatic feature finding makes use of the OpenCV library.

                          License Agreement

               For Open Source Computer Vision Library

Copyright (C) 2000-2008, Intel Corporation, all rights reserved.

Copyright (C) 2008-2011, Willow Garage Inc., all rights reserved.

Third party copyrights are property of their respective owners.

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

  * Redistributions of source code must retain the above copyright notice, this list
of conditions and the following disclaimer.

  * Redistributions in binary form must reproduce the above copyright notice, this
list of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.

  * The name of the copyright holders may not be used to endorse or promote products
derived from this software without specific prior written permission.

This software is provided by the copyright holders and contributors "as is" and any
express or implied warranties, including, but not limited to, the implied warranties
of merchantability and fitness for a particular purpose are disclaimed. In no event
shall the Intel Corporation or contributors be liable for any direct, indirect,
incidental, special, exemplary, or consequential damages (including, but not limited
to, procurement of substitute goods or services; loss of use, data, or profits; or
business interruption) however caused and on any theory of liability, whether in
contract, strict liability, or tort (including negligence or otherwise) arising in any
way out of the use of this software, even if advised of the possibility of such
damage.

Machine Learning Framework

A machine learning framework is provided by Darwin.

DARWIN: A FRAMEWORK FOR MACHINE LEARNING RESEARCH AND DEVELOPMENT

Copyright (c) 2007-2012, Stephen Gould

All rights reserved.

http://opencv.willowgarage.com
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Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

    * Redistributions of source code must retain the above copyright notice, this list
of conditions and the following disclaimer.

    * Redistributions in binary form must reproduce the above copyright notice, this
list of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.

    * Neither the name of the software's copyright holders nor the names of its
contributors may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

Boost

General classes are provided by boost.

Boost Software License - Version 1.0 - August 17th, 2003

Permission is hereby granted, free of charge, to any person or organization obtaining
a copy of the software and accompanying documentation covered by this license (the
"Software") to use, reproduce, display, distribute, execute, and transmit the
Software, and to prepare derivative works of the Software, and to permit third-parties
to whom the Software is furnished to do so, all subject to the following:

The copyright notices in the Software and this entire statement, including the above
license grant, this restriction and the following disclaimer, must be included in all
copies of the Software, in whole or in part, and all derivative works of the Software,
unless such copies or derivative works are solely in the form of machine-executable
object code generated by a source language processor.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT
HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER
LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Delaunay Triangulation

A delaunay triangulation function is provided by Ken Clarkson, AT&T

Ken Clarkson wrote this.  Copyright (c) 1995 by AT&T.

Permission to use, copy, modify, and distribute this software for any purpose without
fee is hereby granted, provided that this entire notice is included in all copies of

http://www.boost.org/
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any software which is or includes a copy or modification of this software and in all
copies of the supporting documentation for such software.

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY.  IN
PARTICULAR, NEITHER THE AUTHORS NOR AT&T MAKE ANY REPRESENTATION OR WARRANTY OF ANY
KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR
PURPOSE. 

Dlib

Dlib, a machine learning toolkit.

Boost Software License - Version 1.0 - August 17th, 2003

Permission is hereby granted, free of charge, to any person or organization
obtaining a copy of the software and accompanying documentation covered by
this license (the "Software") to use, reproduce, display, distribute,
execute, and transmit the Software, and to prepare derivative works of the
Software, and to permit third-parties to whom the Software is furnished to
do so, all subject to the following:

The copyright notices in the Software and this entire statement, including
the above license grant, this restriction and the following disclaimer,
must be included in all copies of the Software, in whole or in part, and
all derivative works of the Software, unless such copies or derivative
works are solely in the form of machine-executable object code generated by
a source language processor.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT
SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE
FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

TensorFlow

TensorFlow, an open source machine learning framework.

Copyright 2018 The TensorFlow Authors.  All rights reserved.

                                 Apache License
                           Version 2.0, January 2004
                        http://www.apache.org/licenses/

   TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

   1. Definitions.

      "License" shall mean the terms and conditions for use, reproduction,
      and distribution as defined by Sections 1 through 9 of this document.

      "Licensor" shall mean the copyright owner or entity authorized by
      the copyright owner that is granting the License.

      "Legal Entity" shall mean the union of the acting entity and all
      other entities that control, are controlled by, or are under common

http://www.tensorflow.org
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      control with that entity. For the purposes of this definition,
      "control" means (i) the power, direct or indirect, to cause the
      direction or management of such entity, whether by contract or
      otherwise, or (ii) ownership of fifty percent (50%) or more of the
      outstanding shares, or (iii) beneficial ownership of such entity.

      "You" (or "Your") shall mean an individual or Legal Entity
      exercising permissions granted by this License.

      "Source" form shall mean the preferred form for making modifications,
      including but not limited to software source code, documentation
      source, and configuration files.

      "Object" form shall mean any form resulting from mechanical
      transformation or translation of a Source form, including but
      not limited to compiled object code, generated documentation,
      and conversions to other media types.

      "Work" shall mean the work of authorship, whether in Source or
      Object form, made available under the License, as indicated by a
      copyright notice that is included in or attached to the work
      (an example is provided in the Appendix below).

      "Derivative Works" shall mean any work, whether in Source or Object
      form, that is based on (or derived from) the Work and for which the
      editorial revisions, annotations, elaborations, or other modifications
      represent, as a whole, an original work of authorship. For the purposes
      of this License, Derivative Works shall not include works that remain
      separable from, or merely link (or bind by name) to the interfaces of,
      the Work and Derivative Works thereof.

      "Contribution" shall mean any work of authorship, including
      the original version of the Work and any modifications or additions
      to that Work or Derivative Works thereof, that is intentionally
      submitted to Licensor for inclusion in the Work by the copyright owner
      or by an individual or Legal Entity authorized to submit on behalf of
      the copyright owner. For the purposes of this definition, "submitted"
      means any form of electronic, verbal, or written communication sent
      to the Licensor or its representatives, including but not limited to
      communication on electronic mailing lists, source code control systems,
      and issue tracking systems that are managed by, or on behalf of, the
      Licensor for the purpose of discussing and improving the Work, but
      excluding communication that is conspicuously marked or otherwise
      designated in writing by the copyright owner as "Not a Contribution."

      "Contributor" shall mean Licensor and any individual or Legal Entity
      on behalf of whom a Contribution has been received by Licensor and
      subsequently incorporated within the Work.

   2. Grant of Copyright License. Subject to the terms and conditions of
      this License, each Contributor hereby grants to You a perpetual,
      worldwide, non-exclusive, no-charge, royalty-free, irrevocable
      copyright license to reproduce, prepare Derivative Works of,
      publicly display, publicly perform, sublicense, and distribute the
      Work and such Derivative Works in Source or Object form.

   3. Grant of Patent License. Subject to the terms and conditions of
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      this License, each Contributor hereby grants to You a perpetual,
      worldwide, non-exclusive, no-charge, royalty-free, irrevocable
      (except as stated in this section) patent license to make, have made,
      use, offer to sell, sell, import, and otherwise transfer the Work,
      where such license applies only to those patent claims licensable
      by such Contributor that are necessarily infringed by their
      Contribution(s) alone or by combination of their Contribution(s)
      with the Work to which such Contribution(s) was submitted. If You
      institute patent litigation against any entity (including a
      cross-claim or counterclaim in a lawsuit) alleging that the Work
      or a Contribution incorporated within the Work constitutes direct
      or contributory patent infringement, then any patent licenses
      granted to You under this License for that Work shall terminate
      as of the date such litigation is filed.

   4. Redistribution. You may reproduce and distribute copies of the
      Work or Derivative Works thereof in any medium, with or without
      modifications, and in Source or Object form, provided that You
      meet the following conditions:

      (a) You must give any other recipients of the Work or
          Derivative Works a copy of this License; and

      (b) You must cause any modified files to carry prominent notices
          stating that You changed the files; and

      (c) You must retain, in the Source form of any Derivative Works
          that You distribute, all copyright, patent, trademark, and
          attribution notices from the Source form of the Work,
          excluding those notices that do not pertain to any part of
          the Derivative Works; and

      (d) If the Work includes a "NOTICE" text file as part of its
          distribution, then any Derivative Works that You distribute must
          include a readable copy of the attribution notices contained
          within such NOTICE file, excluding those notices that do not
          pertain to any part of the Derivative Works, in at least one
          of the following places: within a NOTICE text file distributed
          as part of the Derivative Works; within the Source form or
          documentation, if provided along with the Derivative Works; or,
          within a display generated by the Derivative Works, if and
          wherever such third-party notices normally appear. The contents
          of the NOTICE file are for informational purposes only and
          do not modify the License. You may add Your own attribution
          notices within Derivative Works that You distribute, alongside
          or as an addendum to the NOTICE text from the Work, provided
          that such additional attribution notices cannot be construed
          as modifying the License.

      You may add Your own copyright statement to Your modifications and
      may provide additional or different license terms and conditions
      for use, reproduction, or distribution of Your modifications, or
      for any such Derivative Works as a whole, provided Your use,
      reproduction, and distribution of the Work otherwise complies with
      the conditions stated in this License.

   5. Submission of Contributions. Unless You explicitly state otherwise,
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      any Contribution intentionally submitted for inclusion in the Work
      by You to the Licensor shall be under the terms and conditions of
      this License, without any additional terms or conditions.
      Notwithstanding the above, nothing herein shall supersede or modify
      the terms of any separate license agreement you may have executed
      with Licensor regarding such Contributions.

   6. Trademarks. This License does not grant permission to use the trade
      names, trademarks, service marks, or product names of the Licensor,
      except as required for reasonable and customary use in describing the
      origin of the Work and reproducing the content of the NOTICE file.

   7. Disclaimer of Warranty. Unless required by applicable law or
      agreed to in writing, Licensor provides the Work (and each
      Contributor provides its Contributions) on an "AS IS" BASIS,
      WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or
      implied, including, without limitation, any warranties or conditions
      of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A
      PARTICULAR PURPOSE. You are solely responsible for determining the
      appropriateness of using or redistributing the Work and assume any
      risks associated with Your exercise of permissions under this License.

   8. Limitation of Liability. In no event and under no legal theory,
      whether in tort (including negligence), contract, or otherwise,
      unless required by applicable law (such as deliberate and grossly
      negligent acts) or agreed to in writing, shall any Contributor be
      liable to You for damages, including any direct, indirect, special,
      incidental, or consequential damages of any character arising as a
      result of this License or out of the use or inability to use the
      Work (including but not limited to damages for loss of goodwill,
      work stoppage, computer failure or malfunction, or any and all
      other commercial damages or losses), even if such Contributor
      has been advised of the possibility of such damages.

   9. Accepting Warranty or Additional Liability. While redistributing
      the Work or Derivative Works thereof, You may choose to offer,
      and charge a fee for, acceptance of support, warranty, indemnity,
      or other liability obligations and/or rights consistent with this
      License. However, in accepting such obligations, You may act only
      on Your own behalf and on Your sole responsibility, not on behalf
      of any other Contributor, and only if You agree to indemnify,
      defend, and hold each Contributor harmless for any liability
      incurred by, or claims asserted against, such Contributor by reason
      of your accepting any such warranty or additional liability.

   END OF TERMS AND CONDITIONS

   APPENDIX: How to apply the Apache License to your work.

      To apply the Apache License to your work, attach the following
      boilerplate notice, with the fields enclosed by brackets "[]"
      replaced with your own identifying information. (Don't include
      the brackets!)  The text should be enclosed in the appropriate
      comment syntax for the file format. We also recommend that a
      file or class name and description of purpose be included on the
      same "printed page" as the copyright notice for easier
      identification within third-party archives.
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   Copyright 2017, The TensorFlow Authors.

   Licensed under the Apache License, Version 2.0 (the "License");
   you may not use this file except in compliance with the License.
   You may obtain a copy of the License at

       http://www.apache.org/licenses/LICENSE-2.0

   Unless required by applicable law or agreed to in writing, software
   distributed under the License is distributed on an "AS IS" BASIS,
   WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.
   See the License for the specific language governing permissions and
   limitations under the License.

## Some of TensorFlow's code is derived from Caffe, which is subject to the following
copyright notice:

COPYRIGHT

All contributions by the University of California:

Copyright (c) 2014, The Regents of the University of California (Regents)
All rights reserved.

All other contributions:

Copyright (c) 2014, the respective contributors
All rights reserved.

Caffe uses a shared copyright model: each contributor holds copyright over
their contributions to Caffe. The project versioning records all such
contribution and copyright details. If a contributor wants to further mark
their specific copyright on a particular contribution, they should indicate
their copyright solely in the commit message of the change when it is
committed.

LICENSE

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
   list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
   this list of conditions and the following disclaimer in the documentation
   and/or other materials provided with the distribution.

   THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
   ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
   WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
   DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
   ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
   (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
   LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
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   ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
   (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
   SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

CONTRIBUTION AGREEMENT

By contributing to the BVLC/caffe repository through pull-request, comment,
or otherwise, the contributor releases their content to the
license and copyright terms herein.

Eigen

Eigen, a C++ template library for linear algebra: matrices, vectors, numerical solvers, and related algorithms.

Mozilla Public License Version 2.0
==================================

1. Definitions
--------------

1.1. "Contributor"
    means each individual or legal entity that creates, contributes to
    the creation of, or owns Covered Software.

1.2. "Contributor Version"
    means the combination of the Contributions of others (if any) used
    by a Contributor and that particular Contributor's Contribution.

1.3. "Contribution"
    means Covered Software of a particular Contributor.

1.4. "Covered Software"
    means Source Code Form to which the initial Contributor has attached
    the notice in Exhibit A, the Executable Form of such Source Code
    Form, and Modifications of such Source Code Form, in each case
    including portions thereof.

1.5. "Incompatible With Secondary Licenses"
    means

    (a) that the initial Contributor has attached the notice described
        in Exhibit B to the Covered Software; or

    (b) that the Covered Software was made available under the terms of
        version 1.1 or earlier of the License, but not also under the
        terms of a Secondary License.

1.6. "Executable Form"
    means any form of the work other than Source Code Form.

1.7. "Larger Work"
    means a work that combines Covered Software with other material, in 
    a separate file or files, that is not Covered Software.

1.8. "License"
    means this document.
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1.9. "Licensable"
    means having the right to grant, to the maximum extent possible,
    whether at the time of the initial grant or subsequently, any and
    all of the rights conveyed by this License.

1.10. "Modifications"
    means any of the following:

    (a) any file in Source Code Form that results from an addition to,
        deletion from, or modification of the contents of Covered
        Software; or

    (b) any new file in Source Code Form that contains any Covered
        Software.

1.11. "Patent Claims" of a Contributor
    means any patent claim(s), including without limitation, method,
    process, and apparatus claims, in any patent Licensable by such
    Contributor that would be infringed, but for the grant of the
    License, by the making, using, selling, offering for sale, having
    made, import, or transfer of either its Contributions or its
    Contributor Version.

1.12. "Secondary License"
    means either the GNU General Public License, Version 2.0, the GNU
    Lesser General Public License, Version 2.1, the GNU Affero General
    Public License, Version 3.0, or any later versions of those
    licenses.

1.13. "Source Code Form"
    means the form of the work preferred for making modifications.

1.14. "You" (or "Your")
    means an individual or a legal entity exercising rights under this
    License. For legal entities, "You" includes any entity that
    controls, is controlled by, or is under common control with You. For
    purposes of this definition, "control" means (a) the power, direct
    or indirect, to cause the direction or management of such entity,
    whether by contract or otherwise, or (b) ownership of more than
    fifty percent (50%) of the outstanding shares or beneficial
    ownership of such entity.

2. License Grants and Conditions
--------------------------------

2.1. Grants

Each Contributor hereby grants You a world-wide, royalty-free,
non-exclusive license:

(a) under intellectual property rights (other than patent or trademark)
    Licensable by such Contributor to use, reproduce, make available,
    modify, display, perform, distribute, and otherwise exploit its
    Contributions, either on an unmodified basis, with Modifications, or
    as part of a Larger Work; and

(b) under Patent Claims of such Contributor to make, use, sell, offer
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    for sale, have made, import, and otherwise transfer either its
    Contributions or its Contributor Version.

2.2. Effective Date

The licenses granted in Section 2.1 with respect to any Contribution
become effective for each Contribution on the date the Contributor first
distributes such Contribution.

2.3. Limitations on Grant Scope

The licenses granted in this Section 2 are the only rights granted under
this License. No additional rights or licenses will be implied from the
distribution or licensing of Covered Software under this License.
Notwithstanding Section 2.1(b) above, no patent license is granted by a
Contributor:

(a) for any code that a Contributor has removed from Covered Software;
    or

(b) for infringements caused by: (i) Your and any other third party's
    modifications of Covered Software, or (ii) the combination of its
    Contributions with other software (except as part of its Contributor
    Version); or

(c) under Patent Claims infringed by Covered Software in the absence of
    its Contributions.

This License does not grant any rights in the trademarks, service marks,
or logos of any Contributor (except as may be necessary to comply with
the notice requirements in Section 3.4).

2.4. Subsequent Licenses

No Contributor makes additional grants as a result of Your choice to
distribute the Covered Software under a subsequent version of this
License (see Section 10.2) or under the terms of a Secondary License (if
permitted under the terms of Section 3.3).

2.5. Representation

Each Contributor represents that the Contributor believes its
Contributions are its original creation(s) or it has sufficient rights
to grant the rights to its Contributions conveyed by this License.

2.6. Fair Use

This License is not intended to limit any rights You have under
applicable copyright doctrines of fair use, fair dealing, or other
equivalents.

2.7. Conditions

Sections 3.1, 3.2, 3.3, and 3.4 are conditions of the licenses granted
in Section 2.1.

3. Responsibilities
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-------------------

3.1. Distribution of Source Form

All distribution of Covered Software in Source Code Form, including any
Modifications that You create or to which You contribute, must be under
the terms of this License. You must inform recipients that the Source
Code Form of the Covered Software is governed by the terms of this
License, and how they can obtain a copy of this License. You may not
attempt to alter or restrict the recipients' rights in the Source Code
Form.

3.2. Distribution of Executable Form

If You distribute Covered Software in Executable Form then:

(a) such Covered Software must also be made available in Source Code
    Form, as described in Section 3.1, and You must inform recipients of
    the Executable Form how they can obtain a copy of such Source Code
    Form by reasonable means in a timely manner, at a charge no more
    than the cost of distribution to the recipient; and

(b) You may distribute such Executable Form under the terms of this
    License, or sublicense it under different terms, provided that the
    license for the Executable Form does not attempt to limit or alter
    the recipients' rights in the Source Code Form under this License.

3.3. Distribution of a Larger Work

You may create and distribute a Larger Work under terms of Your choice,
provided that You also comply with the requirements of this License for
the Covered Software. If the Larger Work is a combination of Covered
Software with a work governed by one or more Secondary Licenses, and the
Covered Software is not Incompatible With Secondary Licenses, this
License permits You to additionally distribute such Covered Software
under the terms of such Secondary License(s), so that the recipient of
the Larger Work may, at their option, further distribute the Covered
Software under the terms of either this License or such Secondary
License(s).

3.4. Notices

You may not remove or alter the substance of any license notices
(including copyright notices, patent notices, disclaimers of warranty,
or limitations of liability) contained within the Source Code Form of
the Covered Software, except that You may alter any license notices to
the extent required to remedy known factual inaccuracies.

3.5. Application of Additional Terms

You may choose to offer, and to charge a fee for, warranty, support,
indemnity or liability obligations to one or more recipients of Covered
Software. However, You may do so only on Your own behalf, and not on
behalf of any Contributor. You must make it absolutely clear that any
such warranty, support, indemnity, or liability obligation is offered by
You alone, and You hereby agree to indemnify every Contributor for any
liability incurred by such Contributor as a result of warranty, support,
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indemnity or liability terms You offer. You may include additional
disclaimers of warranty and limitations of liability specific to any
jurisdiction.

4. Inability to Comply Due to Statute or Regulation
---------------------------------------------------

If it is impossible for You to comply with any of the terms of this
License with respect to some or all of the Covered Software due to
statute, judicial order, or regulation then You must: (a) comply with
the terms of this License to the maximum extent possible; and (b)
describe the limitations and the code they affect. Such description must
be placed in a text file included with all distributions of the Covered
Software under this License. Except to the extent prohibited by statute
or regulation, such description must be sufficiently detailed for a
recipient of ordinary skill to be able to understand it.

5. Termination
--------------

5.1. The rights granted under this License will terminate automatically
if You fail to comply with any of its terms. However, if You become
compliant, then the rights granted under this License from a particular
Contributor are reinstated (a) provisionally, unless and until such
Contributor explicitly and finally terminates Your grants, and (b) on an
ongoing basis, if such Contributor fails to notify You of the
non-compliance by some reasonable means prior to 60 days after You have
come back into compliance. Moreover, Your grants from a particular
Contributor are reinstated on an ongoing basis if such Contributor
notifies You of the non-compliance by some reasonable means, this is the
first time You have received notice of non-compliance with this License
from such Contributor, and You become compliant prior to 30 days after
Your receipt of the notice.

5.2. If You initiate litigation against any entity by asserting a patent
infringement claim (excluding declaratory judgment actions,
counter-claims, and cross-claims) alleging that a Contributor Version
directly or indirectly infringes any patent, then the rights granted to
You by any and all Contributors for the Covered Software under Section
2.1 of this License shall terminate.

5.3. In the event of termination under Sections 5.1 or 5.2 above, all
end user license agreements (excluding distributors and resellers) which
have been validly granted by You or Your distributors under this License
prior to termination shall survive termination.

************************************************************************
*                                                                      *
*  6. Disclaimer of Warranty                                           *
*  -------------------------                                           *
*                                                                      *
*  Covered Software is provided under this License on an "as is"       *
*  basis, without warranty of any kind, either expressed, implied, or  *
*  statutory, including, without limitation, warranties that the       *
*  Covered Software is free of defects, merchantable, fit for a        *
*  particular purpose or non-infringing. The entire risk as to the     *
*  quality and performance of the Covered Software is with You.        *
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*  Should any Covered Software prove defective in any respect, You     *
*  (not any Contributor) assume the cost of any necessary servicing,   *
*  repair, or correction. This disclaimer of warranty constitutes an   *
*  essential part of this License. No use of any Covered Software is   *
*  authorized under this License except under this disclaimer.         *
*                                                                      *
************************************************************************

************************************************************************
*                                                                      *
*  7. Limitation of Liability                                          *
*  --------------------------                                          *
*                                                                      *
*  Under no circumstances and under no legal theory, whether tort      *
*  (including negligence), contract, or otherwise, shall any           *
*  Contributor, or anyone who distributes Covered Software as          *
*  permitted above, be liable to You for any direct, indirect,         *
*  special, incidental, or consequential damages of any character      *
*  including, without limitation, damages for lost profits, loss of    *
*  goodwill, work stoppage, computer failure or malfunction, or any    *
*  and all other commercial damages or losses, even if such party      *
*  shall have been informed of the possibility of such damages. This   *
*  limitation of liability shall not apply to liability for death or   *
*  personal injury resulting from such party's negligence to the       *
*  extent applicable law prohibits such limitation. Some               *
*  jurisdictions do not allow the exclusion or limitation of           *
*  incidental or consequential damages, so this exclusion and          *
*  limitation may not apply to You.                                    *
*                                                                      *
************************************************************************

8. Litigation
-------------

Any litigation relating to this License may be brought only in the
courts of a jurisdiction where the defendant maintains its principal
place of business and such litigation shall be governed by laws of that
jurisdiction, without reference to its conflict-of-law provisions.
Nothing in this Section shall prevent a party's ability to bring
cross-claims or counter-claims.

9. Miscellaneous
----------------

This License represents the complete agreement concerning the subject
matter hereof. If any provision of this License is held to be
unenforceable, such provision shall be reformed only to the extent
necessary to make it enforceable. Any law or regulation which provides
that the language of a contract shall be construed against the drafter
shall not be used to construe this License against a Contributor.

10. Versions of the License
---------------------------

10.1. New Versions

Mozilla Foundation is the license steward. Except as provided in Section
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10.3, no one other than the license steward has the right to modify or
publish new versions of this License. Each version will be given a
distinguishing version number.

10.2. Effect of New Versions

You may distribute the Covered Software under the terms of the version
of the License under which You originally received the Covered Software,
or under the terms of any subsequent version published by the license
steward.

10.3. Modified Versions

If you create software not governed by this License, and you want to
create a new license for such software, you may create and use a
modified version of this License if you rename the license and remove
any references to the name of the license steward (except to note that
such modified license differs from this License).

10.4. Distributing Source Code Form that is Incompatible With Secondary
Licenses

If You choose to distribute Source Code Form that is Incompatible With
Secondary Licenses under the terms of this version of the License, the
notice described in Exhibit B of this License must be attached.

Exhibit A - Source Code Form License Notice
-------------------------------------------

  This Source Code Form is subject to the terms of the Mozilla Public
  License, v. 2.0. If a copy of the MPL was not distributed with this
  file, You can obtain one at http://mozilla.org/MPL/2.0/.

If it is not possible or desirable to put the notice in a particular
file, then You may include the notice in a location (such as a LICENSE
file in a relevant directory) where a recipient would be likely to look
for such a notice.

You may add additional accurate notices of copyright ownership.

Exhibit B - "Incompatible With Secondary Licenses" Notice
---------------------------------------------------------

  This Source Code Form is "Incompatible With Secondary Licenses", as
  defined by the Mozilla Public License, v. 2.0.

3.7 Supported File Types

PortraitPro can read and write the following types of files:

Type Extension Description
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JPEG .jpg; .jpeg Image file type that uses lossy compression

TIFF .tif; .tiff Image file type that is uncompressed or uses loss-less compression

Note: TIFF files containing images that have 16 bits per color sample (48 bits
per pixel) are only supported in the Studio edition.

PNG .png Another common image file format

Note: PNG files containing images that have 16 bits per color sample (48 bits
per pixel) are only supported in the Studio edition.

PPX .ppx Proprietary file type used by PortraitPro to store a session

Studio Editions

In addition, PortraitPro Studio and Studio Max editions supports reading the following camera RAW files:

Manufacturer Type

Adobe .dng

ARRI .ari

Canon .crw; .cr2

Epson .erf

Fuji .raf

Imacon .fff

Kodak .tif; .kdc; .dcr

Mamiya .mef; .mos

Minolta .mrw

Nikon .nef

Olympus .orf

Panasonic .raw; .rw2

Pentax .ptx; .pef

Phase One .tif; .iiq
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Red .r3d

QuickTake .qtk

Sony .arw; .srf; .sr2

 

3.8 Keyboard Shortcuts

PortraitPro provides the following keyboard shortcuts at the various stages of the application.

Menu Commands

CTRL+O File > Open command.

F4 Studio Edition Only

File > Open Batch command.

CTRL+S File > Save command.

CTRL+W File > Close command.

CTRL+E File > Enhance Another Face In This Photo command.

CTRL+Z Edit > Undo command.

CTRL+Y Edit > Redo command.

Start Screen

SPACE BAR Brings up File Open dialog to let you select the file to open.

Select Gender

f Sets face as female, then goes to Locate Features step.

m Sets face as male, then goes to Locate Features step.

Locate Features

No keyboard shortcuts

Adjust Outline

SPACE BAR Goes to the next feature to adjust.

. Skip to the end of the Adjust Outline stage.

9
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Enhance Photo

+ Zoom in.

- Zoom out.

ENTER
(while held)

Flips enhanced image view to show original image.

a Shows/Hides Skin Area.

t Selects Touch-Up tool.

r Selects Restore tool.

s Selects Extend Skin Area tool.

d Selects Cut Back Skin Area tool.

h Selects Extend Hair Area tool.

j Selects Cut Back Hair Area tool.

c Selects Crop tool.

[ Make brush radius smaller (when a brush tool  is selected).

] Make brush radius larger (when a brush tool is selected).

0-9 Change brush strength (when touch-up or restore brush tool is selected).

ESC De-selects the currently selected tool.

SPACE BAR
(while held)

When a brush tool is selected, temporarily switches to the pan tool.

SHIFT
(while held)

When a brush tool is selected, temporarily switches to the opposite brush.

ALT
(while held)

When a smart brush is selected, temporarily locks the detector.  This is useful when
brush fine detail such as strands of hair.

F2 Brings up the Save Preset  dialog.

F3 Brings up the Save Snapshot  dialog.

F4 Selects the Reset to Original preset, which sets the controls to leave the image
unchanged.

F7 Zooms the view to show the whole image.

F8 Zooms the view to show the current face.

F9 Selects the Controls  tab in the controls panel.

F10 Selects the Presets  tab in the controls panel.

F11 Selects the Snapshots  tab in the controls panel.

89

86

40

40

38

40
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Index
- 1 -
1:1 button     36

- A -
adjust outline     22

aspect ratio     91

automatic batch     15

- B -
background replacement     62

bits per sample     79, 82

brightness slider     60

brush tools     89

- C -
color settings dialog     79, 82

contrast slider     60

controls panel     35

crop tool     91

cut back skin mask tool     90

- D -
default settings     38

delete presets     88

docking controls panel     35

- E -
edit menu     32

enhance image     17

enhance skin only     18

extend skin mask tool     90

eye sliders     54

- F -
face button     36

face sculpt sliders     42

file extensions     109

file menu     30

file types     109

fit button     36

flipping between enhanced and original     35

- G -
gender     78

group shots     27

- H -
hair area     71

hair sliders     59

help menu     33

- I -
image orientation     18

introduction     6

- J -
jpeg     78

- K -
keyboard shortcuts     111

- L -
language dialog     84

- M -
manage presets dialog     88

mouth sliders     58

multiple faces     27
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- N -
navigator     36

- O -
opacity (brush)     89

open image     14

- P -
pan tool     89

picture sliders     60

png     78

presets     38

- Q -
quick start guide     7

- R -
radius (brush)     89

raw images     109

red eye removal     54

rename presets     88

re-order presets     88

restore tool     44

rotate image     18

- S -
save image options     78

save preset dialog     86

saved sliders     38

select gender     78

session     30

shape sliders     42

skin area     70

skin coloring controls     48

skin lighting     48

skin sliders     44

sliders     40

snapshots     40

start     6

- T -
tiff     78

touch-up tool     44

- V -
view after only     35

view before and after     35

view menu     33

view/edit skin area     70

vignette     60

- Z -
zoom control     36
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